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(A ¥Rk Wireless Setup Assistant)

FE: BRFTENNL T et vy AR, Bk T8 S A 4T ENHLI ThRE
N D2 Py »

BRI 2SR BAE

Windows H F

1 s @ o “FFER” .

2 il “BTRRERR” o “FBRF” , RIGMIIR PR SFT ENHLRE P SO F 3k

3 KKk

FTEINLETT > EREFTEINL > “SZR/E” EIIF > ELRSCRF

4 FEF s EEFIEITEINL, )5 N IKE R -
5 R ILAR TR A

Macintosh (ZE3ChR) F P

1 7 Finder 1 EXGEFTEIHLIC A K

2 X Printer Utility &5

3 7t Web Links &5 1 #.i7 Customer Support.
4 EMulh EIERERIFT EIHLIE N R R .

5 e A BRI AT

THEATERHLERAT (IR T Windows)

RERATTH

1 9l @ 8 “THA”

2 il “FRERSET o R . AR ISR T T BRSO
3 il “4TERRLER” .

4 JHTEDBL FR SR T L

T EIHLERAF
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5 f& “SCRR7 ENUR TR BT .
6 RIS A TR AT R AT

J8 F B 3BT 2

1 3TIFSCRd, WBERIF el 3o = $TH .

2 il REET . CERIC . W S CCRE

3 75 LT R BB WIS .

A 15 “HRPFTET KEPIE T VW TR L ST RAHAE

5 i B .
BB 2 BT BN
S SR P ST, BT DRI AR . IS LR T W 450047

ENBLBAT tEIAEST EDHLSCA e o i AR AT B L IR S 3T DL A R ILAEST EDBLaE T b, i 2l 2238 0f
BT LR AT IR A

I BT BN A

Windows F /

1 sl @8 “FFER7 .

2 il “PTARER” 5L “BBFR7 , ARG WFIR P IERET EOHLRE P S
3 il e k.

4 FERIH SN R LIRS R Z B/,

5 desetelE, EERNE N RTHE L.

Macintosh (ZE3CRR) AP

1 7& Finder i EXGHFTEIHLICAR K
2 X Uninstaller K45 .

3 TR LR ST AR

ZEITEIHL A
EE: WRELIAEIX SN L2238 TIHEIHUR A, (E ST BB 28 8, 1 50 S 22 288 2 A A
Windows F /°

1 SCHI AT FT T R A R I RE Y o
2 FN BRI

T ENHLER AT
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WA b2 )G W ” FURREAT L, EF s et
a i @, g “FER” . RERE BT .

b 7 “IFHIEER” 8 “iBIT” HEDHA D: \setup. exe, H D E%¥ CD 5 DVD KN 2L 154
Cc fi% Enter ##, st “Hw” .

3 e cxam” St pfe S T ERAE

Macintosh (EXCHR) F P

1 SCH T AT IR R

2 JAFTEIHLINS bR 3 i i 2 e Ry

3 BATIIENHL Rk, ARG F IR S LB L (4R AT 4%
18 FH ELER

TH 3T ENHLAR A4 7] LU k93 support.dell.com 3545 .

T EIHLER AT
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e NARFRAN S R A
NG

1 ORIEE AR, el TR EOT.
AL B SR AARIK . AE PRI R R AR TR R A 0] 55

2 EARIKSZARN IR AP R B ARK .
3 HTTHEAR I, A KRR A% .

R WAL ARTKIEANSTEINLN o dR5K N %1 R HUBCE AEAROK SOOI 3R T B, JF HARIK AL 2R3 %
R AR T .

4 LEFTENHLERAT AR b6 mlihf I\ S R AR5K 1

N ARG A S A
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ARTRARF IR TR 2

BETLIEA.
100 K% i 4%

=

o BEARFPURIEAVKMIIL

o WNEEE B TUA ISR, IEAESTEN 1]k, AR
RTINS TEIHLAY o

25 JR BB GAR SATEIR)—TH A .
o MUK SEACIRMILZ
o EFET “B3h” . “IEW” B BV HTHER.
HE: il BT UL, (FURAHERE A TR st gtk il
WIEREAC. PREE40. T -RADGI K.
20 KR A% o ERENBEIRACZ BT, 15 MARTK 28 R BT A 4Rk

o AT WSS AT ENHLE F AR IR 4K .

o CRERCIBRAIE AUBCEAEST BOLAY i sOR T, AR RS U T
FNFTEHIHLA

o BEACFPURIEAUKNIIL
o ILFET “AABEIE” o “Letter RIE” ANTK ST

N ARG A S A
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BETLIEA.
10 M &

o STENM— M L.

o HMFPPRIEFEEILL.

o RGERET MR BWCEATENEE.
TR WRGHE AT N IRET, ] DU B I T, IR S A
(A VAs o S = PR e e T M P (P o VA VA
o IR B A AR SRR, B PR TR, WSS AL
(AR RS aY I

o REEFE T IR E G . WERBIR P RAT S AT G AR R
s THIEFERR RS SRR B M A AL BN AT T
LU DR A 3T BV A AR RE 4T B RS B R IE AR AT & E

25 5RFRZEAC

o SLTENM— M L.

o BEANFPURIEAUKNIIL

o BIEFET “B3Y” . “IEW” SRR THTE.

R “ml” BT DI, (AR T EUE B A Atk 4
WMERICAC ARBEAR. - RRDGTI 4R,

25 SRBCR LR, Rl k. WIE s A

FHTEIR i _E
o AT PRIE R AURIL .
o BIEFET “B3Y” . “IEW” o “BR7 THTE.
R “ml” BT DI, (AR T HUE B R Atk 4
WERICAC ARBEAR. - RRDGTI 4R,

25 KM / St 4R FHTEIR— i
o BEARFPUREEAUKNIIL
o BIEFET “B3Y” . “IEW” SRR THTE.
R “mdl” BT DI, (AR T HUE B R ARk, 4
WA, AREEAR. M- RADGIAR.
10 FRAFL B4R o THI AL EIHR PR IR EIAC,

FHTEINR— i _E
AR TP S A BN AR %
:fé‘gii%T « EﬁJ” N “IEPI%‘»” Ei “/B\ﬁ)ﬂ[-” TTEI] )\%o

N ARG A S A
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BETLEA
50 S BN o OB i L
o HEAR L TB IR ML

IRIFERIRERIA I B

T RAA 54T BN SCRS AN R B B B AR RS L ARGKSBRIIR 7 4T EN R
R XLEBOABCE A N T ETENHUTARIITEL RETRI L.
1 LT ENHLER AR AR i = 241
2 JEFEENNBLE:
o R B B BALRIK AT
a fi @ R “HRIKREE” .
b & BN IR, Rn s @ 1%L
IS K A DS /3 DSEANEILIREEES I AN P EE (74 O B34
o R B B BRALRIKSR Y.
a fi @ s “HRIRTE” .
b S bRk 4RI, e B .
C [RS4SR ST ENHLE FEERALRIR A, SR 4% @ 4
o WURBEA i B BRI T T ENRAT
a A BNk CBRAME” A B L.
b i @ ks “RATERT” .
C xR H BRI ST EIHE PO AT ED RS, R A 12 G 4t

3 A D, ERERE R, B A AR

BN ARHRAN SR S A
27



R SO SR A B AE S H B

1 FTOF ARG, ARG R SCR U LE Tl B B E A B
2 PR

N ARG A S A
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T ED

TEIRRN

o R BT BN A T I 2 ) 405K

TR B FT B AR BT B4 2R
TERRIAT BN SR & P AT LW (0 s K

AFTEV R BRI, VSR NS DT T ENHLIE H (3T BN T
TRV R S I BT AR B

T BN A

ITER IS

Windows F /°

1 FTIF kS, MNPt “3CfF > 4TE .

2 i M7 . “EEIm . I B “RE”
3 ERFTEITE . TR E. AREK SRR FT B UL
4 ik “HERE” % T EIHLERAE I ARG AR .

5 Fuli “WhE” 5 “FTEN” .

Macintosh (ZE3CHR) AP

1 FIIFSCRY, MNP H i File > Page Setup.

2 7t Page Setup XJ 1 HE - BCE FT EIFL. AR5K RS FIFTEN T [A) 6

3 Hiidi OK.

4 Mg Hfid §id File > Print.

5 J\ Printer # St b ik FRAE ST BB

6 MATENIETSE R PR EN I FTERG . ARTR 2SRRI Ao 41 EQ 1
7 ‘i Print.
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B AT H)
SIEAS O SCRATEN S G, 0T LSO BT EVE 1 B0 sR# I ST 40— 4UATED CRIEH)
B A

: 32 mnﬂ%
R

o S HETENE BRI, B 6T BN IUA T,

o YREATENIA I, 4 T RIS 7E, iE RIS AT BN LE I, 45 SRk 58 TS 1T 2
Windows F /°

1 FTIF kS, MNPt “3CfF > 4TE

2 il M7 . “EEIm . I B “RE”

3 Mt

“UTENRE” LR > “UE” X

4 NEABEITERM L, KRGk “BHITE” .
5 fuli “Whxe” SCHFTENHLERAE I A RHEHE o
6 ki “WhE” B “HTEN” .

Macintosh (ZE3CHR) AP

1 FIF3CRY, MNP H i File > Page Setup.

2 7t Page Setup X1 HE - BCE FT EIFL. AR5K RS FIFTEI T [A) 6

3 i OK.

4 Mg pfid 5 File > Print.

5 J\ Printer # St b ik FRAE ST BB

6 1t Copies Xk N & A HITEI I £, SR )5 1L+ Collated.
7 ‘i Print.

{8 FP4T ER

BOANGOUT, STEINLE ST BN — 00 o SLAE A SR 4 HRAH S BNy 4T B O T, A SORS PR 28 — DA Tdge b1y LA
TBEE, TEER LT B R A

Windows F /°

1 FTIF kS, MNPt “3CfF > 4TE

2 i ‘M7 . ‘eI . I B C“RE”
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3 AE ITEIRE” GEIRM g0 XA RS T Y
o MIESATE RS — 0, WL “SEATERE R .
o WIEEITEN U, IHBOHIL T “EITERE R .

TR WA T R T, WRARESEAT Bl — 00 ISR TR, b 201 S 25 X
THT,

4 ity W KT ERHLEAE BT A .
5 $EE “m:}_:gn E/Q “*TE]]” .

Macintosh (ZE3CHR) AP

1 FIIF3CRY, MNP sk File = Print.
2 )\ Printer # S B ik £54T EIHL

3 WL, RN A

4 JAFTENE T H S s b $E Paper Handling

5 M Paper Handling 5k, Page Order 5 135 #irp i £64T EN IR -

o WL EN )5 — T, 15i% " Reverse page order &} Reverse.

o UIELFTENSE — 0, HUNIL T Reverse page order & Reverse.
6 i Print.

e 2 TOCHEHT BB — 5k 4K 1

Windows f &
1 FTIF kS, MNPt “3CfF > 4TE
2 il “BHET . CEEmIC . ETI B CRE” .
3 KRS
“TH EDR > “ATR7 R RS > kP CEIREK EHTEBEZ IR
4 EREA B IRA B IR BRSO DU
5 AR AR T BRI BE
6 il “WhE” SCHFTENHLERAE I A RHEHE o
7 il ‘TR B CHTERT .

Macintosh (ZE3CHR) AP

1 FIIF3CRY, S FHREPH i File > Page Setup.

2 1t Page Setup X IFHEH BB FTEINL. 4Rk RS AT EN 7 i) o
3 i OK.

4 Mg pfid g File > Print.

5 J\ Printer it 2 5k PERRIHT EHL
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6 MITERIEIHH 2 b i $ Layout.

7 M\ Pages per Sheet 3. th 32 F ik F/E i — 5K A% E& IR B SO T4k
8 AR R A A B

9 #.i5 Print.

MAFfiE R BN IR Bh 2 H 3T BN SO (IR T Windows)
B “SCAHTEN” s
o ITENHLLZTE N USB g sl il it M 2% 3E R AE T AL b
o JTENHUMTTSEALAY Ao Y06 04T IT o
. g%;%gg%&ﬁ%&*ﬂZ\@i@é‘ﬂ%MiﬁE@iﬁi#o THZ 36 U “SCRFRIAAl RSO 3k
o THEIHL A2 1Rl LASTRFAFAH B # P K SCPESR AL A B R o
1 BN R BN A KB A -

iiTEN‘Mﬁi)UU%UT?ﬁ%‘&%HﬂL, ITEMHUERAT B R on 5f B2 MBLE R “RBIEE R 7 s “RI B F i
2 QURAF B P R SR SCA, ITEIHLRS & B ah e “SCPHTED” #5.

R SRAF At e % v ) BB 35 SCRS SO RS, 3 S 2 4% b R i SRR L % iy, S84 @ 1l
3 JEFEIFFTEISCR

WRITEIHIAE R USB %
a LI S R PR A AT BN SRS B SO 4
b fi <O LT EISORY.

WARFTEIHLE e (R T IRERS)

a S g b Sk L P A ST B SCRS 34

b f D 1kl RS AT EDLEREE ST 1 R4 o] AL

C BRI, R AL LT Ak AR A S 4Rk, SR G L T AAHT N SCRY

EE:
o WERTFSIHLESR YU RS, FTEIHLAT RES S A A VUMRS o 15 10 IR 735 5 B DX 1R el A TR
.

o WE TSR E TR AU, 12 E TS R R GRS EDHLER A Bl o
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1T BV R3OS

ITEME &

Windows F /-
1 FTTFSCRS, M FHFR P “ 30 > 4TER” &
2 i M7 . “EEIm . I B “RE”
3 KL+
UTENRE” IR > “4UkBM” FHiglk > ke “Hma”
4 RIEFE:
CURIR RS TR HAIER > RS RGBT
WA A RER RS, lES A R
5 EHFTEIT I,
6 il “HhXE” KT EIHLER AR ARG AE .
7 ik “HEE” BCC4TELT .

Macintosh (ZE3CHR) AP
1 FIIF3CRS, SRR H i File > Page Setup.
2 J\ Format for 3l i Sic i P8 O FT ENAIL.
3 J\ Paper Size it ¢ E RIS G B RS
B AT SR AT G E B R, EIE R E R S
4 EPATEN T, K5 Bt OK.
5 M Hiidi File > Print.
6 M\ Printer 3 St b ik FRAE ST EIHL
7 .5 Print.
HE:
o ZRUGFEME R AT ED,
o T HINIELE N IR Pk R T ARIRI BT ED T In)

ITEIRRZE

Windows A/
1 F7IF3CR, MR IR R b ity “3eff > 4TER” o
2 $EE “E,ﬁn . “_é‘iﬁlﬁ” . “iﬁlﬁ” E/Q “_‘&En .
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3

4

5
6

IR

CHTENRE” LR > “4UKIA7 TRIIHR > R EIRARIKRI

IR

“CHRTK RS TR RAIER > SRR AREK R

UER AT SE AT A ARG R, 1S B T
Ty B G HFT EDHLAAT I T A A
$EE “m:}_:gn E/Q “*TE]]” .

Macintosh (FEICHR) HH

1
2
3

© 00 N o 0 s

10

FITF3CR, AN AR 7 5 File > Page Setup.

M Format for 5L 3¢ 5 o e FERR IR T EIHL

M Paper Size 5 H 3 5k PRI AR AT

N SBAT SE AT E I ARIR RAT, IEIE R E URATS
EPEFTENTT 0], AR5 il OK.

MR L File > Print.

M Printer # S 5 b i FEAE T BB

MFT BN T H 5% #i b % 4% Print Settings 5k Quality & Media.
M Paper Type it 51 i ik £ Card Stock.

M Print Quality 5 Hi 22 i $PEBR Quick Print 2% Draft LA HAF] EJ i &

7 Print.

ﬁ?%%)\ﬁ%i?tﬁ HI3RIR

TR AR B AR T B SR AT EIHLA -
TR AR AR ARG AR 2 B B ARIK A 5 220 1 22K
THHIABEAC P PR SRR R AR 1L 25

VAL e B AR 2R AR WERFRAEARA EHE (S AR%E) , HABIARZE AT RESS

SRR

FTEN B & X R Hygksk
Windows f

1
2
3

4

FITP3CRS, SR rh fals “ 30 > 4TE1Y .
$EE “E,ﬁn . “_é‘iﬁlﬁ” . “iﬁlﬁ” E/Q “_‘&En .
IR

“UTERRE” IR > “4UKIT” TRAIER > fe “ B XRN

MR T R R v I A UGS, RIA Rl “BE” .
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5 i “HaRe” KMHTEIHUER I BT A XHEHE
6 $a:f “m:}_:En E/Q “*TE]]” .

Macintosh (ZE3CHR) AP

1 FTIF3CRY, S FHREPH . File > Page Setup.

2 )\ Format for 3 = B rp e R R R 4T EIAL

3 M Paper Size #1113 #.1 i£ £ Manage Custom Sizes.

4 WHE T E R A H e R, AR5 OK.

5 I\ Paper Size S b EEE QI B e RS, AR5 i OK.
6 Mg HA §id File > Print.

7 M\ Printer # S 5 b ik FRAE ST EIBL

8 i Print.

2 (S

FEIT EDHL LA A A0~ BN A R B 4%

AR M SRS o B AR S22 A T A B e o 8T DUNES AL P B A2, s ATHAR
PLEHCT N IREhas, SRJa HAESm A ST EIPL E.

1 KEAF Al R ARSI B8R A SKEh 2548 A\ USB 2 HH .
WATHER WANFEFE

i,
Sy

i F

iy R
o HHAAEREE IS HA A A RRE I T A o N7 UKE) BRI PictBridge K HINLILAS LA
o WAL A AR, WA e &

Bl o LA I D AE IR B B TR EL B A B L e, U

o WURTEEE, WA AR Rty BUH IR
SEALERT, SRR HE AR A R

o ERATETHLC R A AR . 5536
TS FRIAERE R RIS $RICE 2 1015 K
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BE—TRBIR: MIEAESTEL, B E NAFAE BRI, T AN 2 AT A
HLZE . ATAT MG RCR s AT A7 il B s s (3T BDPLIC 8K, 15
WA g2 R AR o 2k

2 SRR LAk CREEE R R BIFE R FE.
EE:

o UnAAT P AT PUM AR B, U T EDE A B

o UWIAAEAE R PR TAERER S IF LG TR IR DN A SXah 2% BB BN KA A il S X A B A B LI A
USB # O, SoRhi BRI AR, SR EIEFeE A LA M.

SCRFHIAA R AN SO 2R A
T SRR
¢ Secure Digital (SD) B
* Secure Digital High Capacity (SDHC) ® .doc (Microsoft Word)
* Micro Secure Digital (Micro SD) (772G ECA%) ® xls (Microsoft Excel)
e Mini Secure Digital (Mini SD) (7 Z GRS * .ppt (Microsoft PowerPoint)
* MultiMedia Card (MMC) * .pdf (Adobe Portable Document Format)
* Reduced Size MultiMedia Card (RS-MMC) (%% | © .rif (Rich Text Format)
ficas) ® .docx (Microsoft Word Open Document Format)
* MultiMedia Card mobile (MMCmobile) (7 ZHEHE | o xisx (Microsoft Excel Open Document Format)
) * .pptx (Microsoft PowerPoint Open Document
* Memory Stick Format)
* Memory Stick PRO * .wpd (WordPerfect)
* Memory Stick Duo (7 ZE LA B .
* Memory Stick PRO Duo (i ZHiE L% e JPEG
* xD-Picture Card e TIFF
® xD-Picture Card (Type H)
® xD-Picture Card (Type M)

fE AT ENHLER AR AR ST BN AR A
N
2 T EHLBRAETTAR L < et
3 FAAFRAR DA YRE AR S Tl AT Gt R B I MO AT L
SR o LN 95 SOR SO R 5, 4 @ LI “ IR

TE
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4 JS4G BRI CATEVRA . RS R .
5 SSHG BOR IR R T BN T, AR5 % (G L.

TR BOTLLESHTENITA MM R FTENEE HOVTE A T 4% Ja BT EN Tt [ o Al 9
S8 SCHIE T RO BT BN s B0 A ek 4T B 21k X (DPOF) MBS AHBIL T BT E 45 A e
F o FAT A I il e & 5 A7 &4 DPOF SCAFIR, DPOF GEI0A 4 HY Lo

6 S A A A A Sk R B B s A ST B R BT, AR % R JuAL.
7 R AT B
: W€l o B
b Al Sk R B
C WHESEWE )G, WREMK Bk kg, Ntk B e
8 & “¥fa/ BH” HHWERASE AT,
YRR PR R AT RN, BR R R B R s AT W 85
9 ji Dzl
FER: BRSO, AT BN TR E 4D 24 ANIE, SRR K SE A TR G T B SRR B AT .

fE AT ENHLER AR T AR g 4 R
N
2 RN R R Y 28
SR o L 95 SOR SR 5, 4 @ LI “ IR
3 AT EDBLBRAFIA b G S L < RHIHTER”
8 [RETHRIEAT T e HL PR A T ED IR I, 485 1 (@ JeH
B[R A A e e HLEE PR AT B I
6 JLH bR kL 2 [bR, Ak B AL

e MR R AT

73E TR AR o

B B .

I 25 5 1 23 5 A 2R

ZBRALIR LR AL EAT P 5 S 2R .

Jig¥e WIS B B0 N e R, R 90 TR

RAOMRR PR A, B R Ot BR O sl A AT BN
P A O R A NI o

7 G RGP B
8 SuSdh bR Hk ke 4 R, AR R
9 SeE 7 BNk A w [RS8 A % G L
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10 WA H I FEAT N
: W€l o B
b kR AR
c fu B L RAF I B
d JSida LR E kiR R “gkgr” , AR)E e B IR
11 % “Rfa/ BH7 R EEASE AT,
YRR PR R TR, BR R R B R s AT W 8 5
12 Ji <D 44l
FER: ERS AR, AT BN GO SAURCE 4 D 24 ANIE, SRR K SE A TR G T B RN B AT .

E T ENHLER AT BN B & B
1 BT

2 AT EPLRAR TR L1y < it

3 ARSI YRR 28

A (LTI

WRITEIHIAE R USB %
o SYIIE AAFAE VAT, B A T A BT T, IR ETHURRE [ SR R A B L
R FH TN

WERAT BN e (R THERS)

a SLfE AR I AR AT G L

b 824 b i A RS A R A IR (TSR, S84 (G 4.
C ALIEEATEN

o CUIEREENJE, PR ARG S AT IE IRV R TR SR B AR B N B
BTN Ao
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M PictBridge #AZREAHNLH FTENE
R B AHH LT S HF PictBridge £iAK, n UL VIS HE NSRS AHNLF T ER I, B &8 5L,
1 ¥ USB HLZ5 ) — i i e e B AL L
VR 1 FH BE R B AL PR AR USB Hi4s.
2 % USB HLZ5 15— ddi AFT ENALET AT PictBridge #2101+,

EE:

o THHINERS AN LR E ) IER) USB B8 WERANIER, BB ANHL W] e S gehar ik — A N A7 XS 2% »
BCE FTEIHLERA T AR 2 7 bf B rT R BB R A5 B o TH S D A AN U B SORS IR ECE 2 1145 6L

o FTEHURRX KRBl — P A7 fifi e i

BhE—TTREMBIR: M IELE M PictBridge M7 ECRAHBLHFT EDEF, 15 AN fih
BULM AL, TGRS AEMTHEE O AP B s h s T ETRLIX
R, AR R AR E K.

3 4R PictBridge R LY, JTEIHLE /RBE o MBLE R “EREEMIUEHENITENRA . # e #
HIEFITEIHUEROARE. 7 -
4 QRS B SRR T BB
a f% @ fHEE N “PictBridge” £,
b SR H kAL P BT BN IR AR RS L ARsKRAY L IR RO AR - o8 I i
1 (G .
R fTEIHUR AR ST EN A, BRAR AR AR L 0% T 4T EN B .
5 1S AL SCROITA64T B

TR AFTEHLIEAEST ENILARARAE I, S SRS T HUANL, TSR E R, SRS PRI AR L P b AT 4T
B
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i R TR AT ENFF A B H R A

1
2
3

FEN A4 Bl Letter ]I AR,
ST ENUERAF IR 1) <2 4241,

TAAFAE R BN A KB 35
AR SRAF A e 4 TR I G 35 SCRS SO g i, % @ Felis e “BA .

4 B B Rk, ez @ AL

10

11

12

PS4 bR SR A AL R T ENRE 5K BT B 0

T ARG LN B TET ERE 5K T -

o Jyiilif) 20 5K CRAF s P IR T 21 20 5K)

o Nfitli T AT A .

o JZFUYNEE Can RAFE B I R AEAN R AR o QORGSR T Lk, 305 S 42 >k
e BB T ME R T, AR5 G H DR A T A ik

$% <D .

FEGK TURF 3T BN H K

IR I B4R PP EATEN IR . RESKIEOR I B, RBRZ0IR . FRiD . T BRI ARIR R .
TR AT, TR 8 A 1

MR hE LB PRI I, i @ L SRT R SK TUIE T RSO A R O L
HR: WIR “REETRI WA B SoRbE b, U B BN, ER R e
$% <D .

FTENHLIT A4 H R 5K T

FNM 4K

TR AR RO 5 AR K DU P B A ARk R — 5L

% “Rtn/ BB HHCER OSUEA T,

MG PR O R (TR, B R L R AT 22258

$% <D ALHUITARIT BN

R BRI R, W T BN TR & A 24 NI, SRR SE AT S T B RO B AT .

fiE/l DPOF \EUHEAHALAH T BN A
U A8 MRS ST B 31 SU(DPOF)ZhAE, I ELF - U8 B AE M AL, IS PT L iz 4T

WRLERE L RESKIE T 3T EDJLORAIMAR ST EN B o A RORE AP R A AT EDHLA s K AT D LI BAE 3T BT 1
Jeis ATEIHLAT OGRS

TR A RUSR B AEERSARNL B, 2RI E T T RS, TEBA R ST ENBLIA AR TK SO A
THEAE DPOF &2 RS .

1
2

FNM 4K
ST ENHURAF IR 1) <2 4241,
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3 AL
SR AR RMBEREE

84 RSN R AR TR R @

B JALf IRk LR “FTENRABNLE R (DPOF) ” , SAJG % O T O Y
VERG: PUATEAR A% P A0 IE] DPOF SRR, BI04 2 B

VR BAELAEACR, RTE TR S b 24 AN, S sE A TR T A SRR

FEARTK ORI EEAT 4T B

B B 7E 4R K X E4T 4T EP
HBOHFT B A PR T SELEFTEIHLIY S ) WS kr A4 Fil Letter RS 94tk . Wi A& S RS Ay A H 3))
X&ETTEH%WF, B I SR A At R P ARBK AT XU T B, 15 23 AT G B 4Rk PSR EA T T B
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3 i OK.

4 Mg Hfid §id File > Print.

5 J\ Printer 3 S f b ik $RAE I FT EIHL
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K BB A FATESCACSCRY . U118 5 BT B SO R AR SOk, 18 L AT BN 2 R 47
B A B A,

U EESARBRIAFT B 2K

Windows A/
1 s @, SR “FFR7 , REHd BT .
2 7E “TFHRIER” 8L “iB817” HEHHi N control printers.
3 {4 Enter £, =& Hdi “HiE” .
FTEIPLSCAE IR o 13
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3 NFTERIEIR S H % o % 5 Print Settings 5% Quality & Media, HUv T [ #:4FE R 4

4 )\ Print Quality 3 3% % 3% £ Draft o, Quick Print /5 4T B

5 I\ Presets #fi % ik £ Save as, SR A B E R E AN — A FK.
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HR: EXFE N, EHRE A 22D 1/4 JeF s .
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TR WAL ] WPA 5L WPA2 224, 4R I BRI W 26 I A T 0 22 A ME RN, 15 1%
P C“WPAANN”

ITEN R 4B i B R
25 5 A IO T I IOT ELIORC B, HEATEDALN IP LA MAC St
EIN 2L
2 AT EDHURARTTRL L\ $5H1L.
3 Rk L < RERE T, AR B AL
4 fi G kL de “ATERER” .
FTEWBLKF £ ATEN L3k 4 BB 1.

FETC LM 2% mH 23T BIHLAT T 1R B
B R TEIHLLASEIUICEAT B, f s B A -
o I ML, WRR SSID (s v B RS
o TR AT T I R S I Y 2% 2l 4
o eEY] (WEP s WPA/WPA2 #])
W E B R M 2 WEP 15l WPA/WPA2 4], I EAEIEA S Cogighdy) waEIFaEE ZatbE .
R N A WEP 2421k, WEP Z4N1% 0
* 10 ek 26 M NEEH TR, N AR A-Fo a-ffM0-9.
2
* 5/ 134> ASCIl #4F. ASCIl FAFdf v BE . HU7 . AR5 AT A7 B A, B4k 210 74
WS N U WPA 5L WPA2 224, WPA ZH N 1%
* 64 N NBEH AT TN AT UIEA-Fo a-f10-9.
2
* 8-63 1 ASCIl 7. ASCH Pl bl. Ayt drmifh o M) IERAL EERBIIN 745 . WPA B
ASCIl T4 E X 70 KN
AR IO I 8 A ] 2 it MISA S 245 Y]
HE: WREAME ST EAUITER M) SSID, FISAT VAL 4G FL 2% (1 02 B FH R 7 JF 2 4k b 4

ZRe IR TR BN 2% 1) SSID sl 5 5, 1S RBERE N SRR SR, B 5N R
SR N R

FETCER P 28 7 & 24T BT

P AE T 2 TP s e TEDBLZ AT, WA

o I T I EL 8 TR S0 FLT DLE R T

o GEBAROUEFPUE AR B A T LI LI .
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Windows F /
1 KA T IR A SRR
2 NI APLE .
WA bz Ja ol FHmR B I, T3ttt
a il @, Rl IR, REsal ‘BT .
b F “JHHHER” o “ia17” HEP i\ D: \setup.exe, H A DJE%K) CD ok DVD K528 K54
Cc 1% Enter 5, i “HAgE” .
3 g g G b e R TEN L.

Macintosh (F3CHR) F P

1 AT I N AT

2 FTEMLIM G b T 2508 i 2 36 f2 7

3 BT Bl R, ARG R LS E e AT A .

FEHAR VR =247 Bl

FTENHLAETC R 2% 225 HR ), S P AT ] TSR LER ) LU e 2 0 i) SEATEDRL. (HJ2, b2 A
7 EEVT AT ENHLA T S L B 2R T BN LRSI Y o WNEE 2R IK ARy, 8 B AR — BT L s AT i B
i, BRI ST B T EIHL

Windows F /°
1 KA T IR A SRR
2 NI APLE .
WA reh 2z Ja ool FHnR A I, T3 ot
a il @, Rl TR, REsal ‘BT .
b 7F “JHHHER” o “ia17” HEP4Hi N\ D: \setup.exe, HA D L% CD ok DVD K% 25K 54T
Cc 1% Enter 8, i “HAE” .
3 T EALEE R B BRSO U AL e DR E B FT B L.

Macintosh (F3CHR) F P

1 AT I N T

2 MFTEMLIM G b T 2508 1 2 e f2 7

3 BT Bl R, ARG R L S E e AT A .

Wi-Fi $57R kT B Ui B
WiFi ST I T B S AT DL R
o« REARUFHBLL
— FTERHLI S EL A T TP
— FTELEATHE S M AL T B BB R, R R AT R R DA

BES
61



o REROARLTREINZ
— TERLBAT i, ik &M & A H] .
— TEIHLEZACE T Ad hoc 4%, (HIEIUAE B AILARIK Ad hoe ¥4 REATIE IR
o BONIFLRL T EILZ —:
ITENHLE Y T2 AN fl Rkt tias) AIvE
ITEIHLIEAE 20l S Jo e N U EA TR, (ERE AR AT i G MY P R B ek IR A
C2eid Fe B T LR RN OGP T FLS T R AT T, JF HATEIHLIEAE 2210 P 4 7 Tl T
ITENHLAJC L 0 B AT REAS AT 2o
o SROFIRITENLERAE DML, JFHCaE& e, LU

TR TLE TR F

DL i 4 SIEH TS LA AT H o2k vi i box A 7 LR & —42% box 141 1-: LiveBox. AliceBox-
NOUF Box. FreeBox fll Club Internet.

TR IR R B Z A

o TR box BT IhbE, JFH T LIETCL M P E ] . RN E box DUEAEC Lk k45 h s 1 ) 3 %
HOME R, WS BRI box —i S S KU B SR .

o TEHHINER box HLIRCATIT, JF HAEMHH N CIT I FE AL L M4+ .

[ 45 I TE 2 P 4 A T B AL
1 BB A SR IR Tk I b e B R T DL
UHURERE PG, IR A
2 WHLIEI box SR — AN / VAL, i AR 4 2 R L
VERE: $ORHK / VERHEHLZ T, S5 5 MBI IR S AT EIHL I 2
< JEAEET I
MR TC L P2 I P PR P, AR5 Mol ke
BRI (R 2 M 0 B SR AE B e
a BN L4

Windows A/
B “RFVBEIMEE” .

Macintosh (ZEIChR) A/
MHIF ik $E Other Wireless Network, 445 .il; Continue.

RN PSP R AR Ay
ERE: BT box FIEHS. Bl box —HAEH# B SCRY s box (1M i3k 1T WEP. WPA 5
WPA2 4], MR Lt TR 2 a1 s8], s i s el i 9.
4 RIS R e AT R AT
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Eipchm ol | kel
TERZHI LML, fTEPLK < DHCP H 3 Bl — 1P bk,
1 B4 BCE, RVFTEHLA M Z i) DHCP Jilk 4545 #—~ DHCP i,
2 fTEN—IRMZE BB O, B YA FTEIHLA B 1P Motk
3 FTIFMIG Y, SRS EEAS A AT EDPLIY IP Hbhk. % Enter .
HE: WA TR, 5 AR E, DMEIERTT T EIHLIN L.
4 i “FE > TCP/IP > WEEHA IP Hullk” .
5 78 “Hhbk” TR N EAE IR E I 1P Hudik, SRR R .
WA, TG GO0 YA B R A TR NS P Mk, AR5 4% Enter .
MESFHPEZHER, ESERRGE AR

ZREWRT L RE

T AR ST ENHL e e & (B ic & ) 2 f 22 48D, TEARIR IR A R G R4
Windows F /°

1 @ s “FFaR” .

2 i “BTRRERR” o “FBFF” , RIGMIIR P ESFT ENHLRE 7 SRk

3 fKUESE:
FTEINLER > WWRERIFTEINL > “RE” Wk > TRRENHER
4 RIS R TR S AT R A

Macintosh (Z3CHR) FF
1 M\ Finder HKIRIEF:
Applications > ZEFEIE FIFT EIHLSCAFR
2 Xt Wireless Setup Assistant.
3 LI EANL A EEE ST A

RRTLEE

Bz Ad hoc oM 2%

TR AL LU & F, B L3 — Ad hoc 4% .

o WAL i A M 2%

o WHTEME: (HEBHHHHENAA LMK IEH )

o FSUHAEFTEINLRNAT AT To 2 WX 4% 38 Be o5 1 T H AL 2 TR) 2228 — AN Pl V7 R X 2%
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EE:
o FEVETTURHEEAE 207, E RN I TCEE P 4 3 e 2% IE A O ReE B v R0 B, JOF HoaT BLIE S TAF
o IRAIHEREAT IR S (oM 4y ) eI 4. IXFP LS 2223585 Infrastructure /25,
o WRIETHHEMAT “ MyWI-Fi” 5% “ Wi-Fi Direct” , 14 0] DL B8R R I TC LT ENHL. 5S4
THEHLA S Bh SRR £ 4 L.

o FTEIHL— R BEAE— NG MG TPk T . 78 Ad hoc JE2k M 2% th fic & 4T ENHL AT LA S T ERHLAE HoAth 1)
T M 4% (Ad hoc B Infrastructure) 1 T4k,

Windows Vista 55 & i A
1 il “0 > EHIER > M Internet > MAFIFEZEHL7
2 il “RREEEMNG > RRLL AN R GHENETHEND W% > T—37 .
3 AW E I Ad hoc M4 1R ST HAE . (Rt fEH:
a ISRV PIFT EPHLZ 8] R 1 255 1) gt — AN 4 44 Bk B8 SSID .
b X TNEMM AT, EMIASHEFHbIC S T AN, B KE 75,
C M AT RRAIRFIERE “WPA2 NN B “WEP” , ZRJE 01— WPA %45k WEP %4,
WPA 5 AN «

* 8-63 1 ASCIl 74f. ASCIl ‘FF B Sy Mn] DIAESEAE B4R B 747 . WPA B P
ASCIIl 745 7 Z X 7 KN

P
o 64 M NHEBITAE. NI A-FL a- TR0 -9,
WEP #4150 )
o 5L 13 4 ASCI 54 . ASCI FRHUARFRE . Heey AT BLf A EHRE0H0 744
#

* 10 P26 N ANEEH AT TN PR A-Fo a-fM0-9.
d il MR Mg EM. ETIAGHERIIC R T A, BRERS TR

Windows Vista #5243 %53 M Ad hoc 4%, Jf HAZasrE “IERBIME” e ] M &b, Roil 5
HlE 58k 1 Ad hoc P45 1L .

4 P Windows 7 il IR AT HEAR K 2 1
5 AN LR CEL, WE I S A LR SR T o g k.
TR WEALER M S S, B R AT S s X AL

6 M o kA, THRAE AR Mg XA 2 eE . MRS ETTEINL, DU ERE
Mt S .

7 R 2 AR 2 AR BAOREAE R A by, AR RAE T
ERE: Windows Vista tHEHLE R R 802 i, BT REF L E P &£ #:3] Ad hoc 4% .

Windows XP
1 35 “FFER > BHIER > A Internet &3 > MKZERE” .
2 figgrsh “RRMEERER” Kir.
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R BT, R E.
R WS T, WML E R C A T .

4 figipdy “REMAER” K.

i “EE > BERMGEI R .

R R “ToZ Mg I REA B, SRS 5 =7 AR R R A T R . b
AUE AT BB Ad hoc TEERIMZ% . TS B o =7 B I B SCRSSRIBCE 22 1945 B

6 %+ “F Windows RECER M TLLMBZRE " KILHE,
7 7E CEEEML” N, MR AT L.

TR, AR “MIBR” AR IR 4 .
Ly % Q14> Ad hoc (%%,

9 7t “Mi5544(SSID)” HEHH 4 NI A BRI JO L I 48 44 K

10

11
12
13
14
15

16
17
18
19

20

21

22

K M 8 2R, AT IO 2 B B A I ] BE 2 i B AR B TR A S HER TR T T
FaNN R PNCE ST

WERFIR P B “ MG KA, THERE “9TIF .
MBI SR “WEP”

AT AL, TEHOHIET “ Bah o EIRALIEY]” IEAE,
1 “E B HEF A WEP #4].

R M WEP 3 4], T R B E I ] fe el 2L B e B HER I IC sk T A
W, BRERE 7,

5 WA 17 HE A A [F] (1 WEP #].

wrh “EXE—AENBTHENL GRKD M2 BRI R I,

TR “BARE” RHITITINE H .

BTSN AT RER £ L0 PR PUIDET IO BEE . I R A R I P 25 FRIR S«

a fiiipddy “TTERMAER” K.

b il “BEATRHKLLRER” .
o WURMZECAH, EUR LA R, 1E1EFE Ad hoc W&, SRJ5 il “ER” .
o UWIRMSBATIHEL, &)L, RJEHRS “RIFTT .

AN LRPAICAE, NG LT SR B AT IO 205
TR WAZIER M S, B A5 R X AL

uf I g R RIS, RS I M s LRI 2 215 R TSI E TP, DUEERAE
ISP -

RS IR 28 A0 B 2 2o A5 R ARAFAE A3, AR RG]

Windows 2000

T2 [ B[] 85 PR A 2 I 2 3 B i aES S A3 10 35 B SCR SR XA 9GAE Windows 2000 HHC . Ad hoc 2% (1115
Ko
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Macintosh (ZFEXCHR)
1 2 Airport 1% & :
Mac OS X version 10.5 2 & & R A

M Apple S 5K L+ -
System Preferences > Network > AirPort

Mac OS X version 10.4 B,5E 2. R4
M Finder HK IR L FE
Applications > Internet Connect > AirPort

2 )\ Network Name ¥ Network 3 Hi3Z #. b #1. 5 Create Network.
3 1) Ad hoc WG — N2 FR, K5 i OK.
EE: BRI FRAE DR AE 2 AT, DAk kA .

I Ad hoc Jo&k M4 i3 i T ERAL
HER: FTEHL— LR — AN M4 h T . 78 Ad hoc JEZk M4 Hh L & 4T BV LA K 4T EVHLA T oA
Fic B ik 1 ek 4% (Ad hoc 5% Infrastructure) Hlfl k.
Windows A/
1 s @ TR .
2 i “PrRERERR 8RBT, SRR MBI R R EDPLRE S
3 KRk FE:
FTEINLER > ERERHTEHL > “RE” E R > TREENHAER
4 FIRIH AR B S TR
H#E: Windows Vista 1 HLE B H 32 5, 0T Red 2 E Pk e s3] Ad hoc Mgt

Macintosh (Z3CHR) FF
1 M\ Finder HKIRIEF:
Applications > LR 1F] EIHLSCAFI
2 Xt Wireless Setup Assistant.
3 I EANLS A R ST A

i WPS L EFTENHLLAMELZ MM ((XFR T Windows)

i FHl Wi-Fi Protected Setup(WPS) n] LUZRFARIKG VHHLELFT EPHLES In BN I Jege i 2 b, RA e ml B H 3ok 5
Kyl 31 & SSID A1 WPA %4/,

1 IR R okt thds) SCfy WPS.
2 SN, AT SIS R R R SR AT A .
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EE:

o WUREEAEH WPS YUMBH 7 NI AFTEIL, R A SR DU, A BT B 8 (1L
e

o WIZATH WPS BCE T EIHLLMETCE A, (EHTCE S b BB B AL ISR WPS. T R Y 19 44
AN WPS [, MRS PR i g A SSID Al A PEfR K

7£ USB Mk [ #: (XFRT Windows)
AT AR P 18 10 75 2 U o5 I B T ENNLI i . DU R P BRI e 18 © e f2 e — PR e 2R T S T 18 I FT ED
WL, I HELETENLEZ22E THENRE RS . R SR E R @R T W ME, 1530 51 %R
FAY I 0 0 225
B T T
1 @ “FFam” .
2 i “PrAERER” ot ‘BB, G MIIRFIERFT BN SCaF k.
3 MKIRIEFE:
FTEINLER > EFEMITONL > “R’E” LK > ERRENHER
4 AN LR ST EAE.
EE: L E LT, N BT T B LRI T H ST ML USB HLSE .

P At (USB)E

1 M USB g il SIHLAIFT EIpL.

2 M4, S Windows $REI IR RIS 24T ENL
VERE: 1 AT LLARSE I T B AT B

£ USB MckiEZ 2 a## ((XfR T Macintosh e 3CiR)

AT DR 8 1) i %‘&E&EWI%‘“E’JTTEN‘}IE@?&E PUR AP SR AR E 18 4% I — M B 2R R . T 9T B
Bl WIRMEAERCE LA B S T e, T2 0 5 SR 5C Y o] AR 1

PR TRER

1 KPS I IR o

2 ST EHLIM ST BB i e e«

3 Xt Dell Extras > Dell Setup Assistant.

4 R RE AR S ECE ST EDHLLME S

HR: ELARCE LR, AT EWIFIERSTEINUR TSN USB M4k,
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Fe B A H(USB)EH:

1 K USB HE50)— BB e 4T EPLS I USB #51 . ¥ USB WL ¥ ) — o /a1 H ALK USB 42 1
I

2 SINFTEIHL:

Mac OS X version 10.5 5.5 & R Ak :
a M Apple K REFF
System Preferences > Print & Fax
b i+,
c ‘i Default £+ > EFERFTEIHL > Add.

Mac OS X version 10.4 E.5E 2R A :

a 7t Finder i I %15 Utilities.

b X7 Printer Setup Utility % Print Center.

C 1t Printer List X 1HHE H £ B FH AT EINL, AR5 ki Add.
d M Printer Browser A MFTEINL, 4R )5 i Add.

3 JiANTHIBN G B WR A B e i A L E BV AT EOHL, B LA

£ Windows 85 F L= — 54T EHIHL
1 & L B TERHLI o AL
a A FRESATIHERVHENL R CSCHERFTERHLIL S, AR e LT LU IR« 48
J&” e iE 2 Windows SCRYZRENAT OCE L “ SCAHFFFTERHLAL " BIdR .
b 7T EATIT DT e T EDLAR A
2 HRIRFTEIHL:
a {ESTEINABERTFEAL b, S CUR P BT R A -
1 il @, s “IFeR” . RJEHd “B1T” .
2 7F “THRHER” 8L “iB17” HEPHiIN control printers.
3 % Enter 5, s Hl “HR” .
b AT EIHLE AR
c il “HE” 5 “ITENLEH” .
d 78 “IL” Em-Rhigde “HEXEITENL 58 “FEERT .
e HMIAN—DAETIAMFTENHL AR, R)G s “He” .
3 e AL e AT EIAL:
HE: WS IRERA HEEEAT BT AL
a LU D BT A
1 ik @, s “IFeR” . ARG “B1T” .
2 7F “THRHER” 8 “iB17” HEPHIN control printers.
3 % Enter 5, s Hil “HR” .
b AT EIHLE AR
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c Hii “BH” B “TEVRH®” .
d il “S0 > %n¥w 0 > Local Port > Frug 1”7

B NARE €338 P i 2 AR HE(UNC) 1 3 144 7 @%E&R%ﬁa‘%f SRS 68 DU 2D IR 2 R E AT EIHL
FRRe S AR IZ A LU R \\IRSF 23 \{TEIHL.

i “HE” .

FE “ATEIHLER 107 REAE A il “3REA” .

TERRINAE “3m 107 IR Fpak R OB I 1, ARJE el AT .
i “HE” .

(1]

- T Q =

£ Macintosh (ZE3CHR) 35T FLZITEINL

1 7t Finder £ 1fi - #.f; Help > Mac Help.

2 7F Search 7-BtH#i N\ sharing the printer on a network, #RJ51% return .
3 LA aesiih Lk $ —27:

e 5 Mac OS X FH P 3L B ITETNL — o il Mg b oAb 1] Mac OS X version 10.4 5 5 &5 il A4S (1)
Macintosh 1AL & RAE 1K) Macintosh 1581 LT EIRL.

e 5 Windows P SL =BT EIHL — A VFRIZ% 1) Windows 5148 3% 8248 %45 (1) Macintosh -5
ML LT EIHL.

4 RIS R TR AT R A

HERE: Windows H 7 ] LLZ: [ Windows 5 Bl SCRYIRICAE S7 I 2541 ENFL %42 1) Macintosh 1AL E
o

Y 28¢5 W, ) 25

14 7 Wi-Fi Protected Setup?

Wi-Fi Protected Setup(WPS) it — i i .22 4 ML EE, i LLA s e JELk 5 W s PR T g 2 A, R
TR T AT WisFi BRI, R 15 2 0 4 U 4 L T P9 44 44 7 (SSID) AT WEP 5, WPA 21,

HR: WPS HChRlid B N i (T i ad) BEAT I v b 45 .

FTEIHLSCRE LU R TR IE L B o e M 45 «
o A RBFAPIN) — K537 EIHL B A DU S 5 A BN i e BEE
o JZHIAE(PBC) — FE4RE 1 BUN IH] N 20 % AT ENHLAR A R B 2L

BN PIRRIC iT B B R e 5 A WPS:

*, WiFi PROTECTED

" Y/ SETUP

o

WA FRETECTED

BT AFERS N U 5 T8 S T 4k 213X 28 WPS f#ihse.
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UPESRICE 2 A7 SRS 2 B B AN E RN s ) WPS SR TERIE R, S BRI il fe i
SR, BE LRGSR N R

8 B AT AR B TR WEP 45k WPA 5457
o SEMRGSIAFIER.
— S RS ) IR (A7 A WEP #5150 WPA #55).
= IR LG Intemet ST JOTAISP) 46, 1650 LLAMR NS S et i
o SEIBRENEA S Rl —REEI B,
S B A SR PRV BR A B, 65 T BAZE D SRR BRI I £
o M AT AR,
1 FTIT R TTRIE %, AR ZEH RS P A BE A S 1P ML

EE:
— WESRBEEN R IP il TS BRI S 2R O B SR, s SRR R ST SR
3

— WRGEAE T ARG A, TR A ARG A, DMEIERITIT R L.
2 YRR, TR R A .

ERE: WEP 4]k WPA %4 52 N SIS AR o S50 a] LA VRS U MR S B . WEP %4
B WPA 24 0] LA A VET BV T SEH LI B R IR Z M 2% v
3 &4k WEP #4]5 WPA %54,

4R SSID?

R 1% B R (SSID) A F TR A JCER I 4 i — N 44 FR o 48 TP K T 12 o AU TG 2 245 1) SSID, 15
MGG HAHIE R H, TELMZ) HIH SSID LLAVFX IR P I e B & BRI 4% . T 2242 5K,
A AL 4k SSID.

SSID % 1] M 47 32 M FRESECE T4

W EL AT LA 23 A) SSID?
* MHEMAR CLE&H M) ME.
RN RUIAT B R Z I 55 2, 7l LU P A 28300 B g il
o R A RTINSO SR T L M SE IR 208 T AN AR o
R MG RGOt TN TR, TRV ER BRI L LBs, BfE%H SSID.
W ARAF AR S TVEAN e R BIE 1) SSID, 1 S8 RZ SR AN ABER .

Ha R

W 2% e 4 2 I L BB 2O B AT I AR B, Bl SHL. STEIRL. DURMISRLRAS . A A
HEs . — AW LURBATER I JER I B RIS e ek i
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WA PR BB B 28 BT A R 2 2R B ?
o SRS R,
S I I 10 N (A7 A I TG 8
o BRBERGHRIBA S CRgBi s — RIS,
o HrEEIE TV 1 IR I IO T 71
RGBT S, R TR

TR -ac oo it
10 M8k 26 A N3 745 | WEP
i
5 A8k 13 > ASCIl 74
64 AN EEH TR WPA 1, WPA2
i
8-63 /™ ASCII F%%

EE:

— NSRS A-F. a-fF10 - 9.

— ASCI AR s RE B fny IR SR BB 7247
o NS LEEREERE,

1 FTIFM TN 8%, SRS 7 RS th i N3 A 500 P Hihik .

EE:
— WESRBEEN R 1P il SRR SRR G B SR, s SR R ST SCRE N Bk
3

— WORTEAE TACEE AR 55 4%, TR I AR AR 5 A8, DM IERRFT T M 3L,
2 BRI, AR R A .

HRE: WEP %98k WPA B N B i ANl . 8565 T DL A VRIS UG IR A R B . WEP % 4]
o WPA ZH AT LA SR VFT ENHLAI T SEAL I SIS ) JE 4 25 7
3 Ak WEP & H]al WPA %4,

K PR AT BC . ?

B I AHUIRAST EDHL SR R 2 p AT I, AT AR AN/ Py B e 2 ke o 2k M 2%
T8 A o

R LM 22 A R R E 22 m 4 o LT R DY AR Y.

FER: T BT EIHURR WA T A ST EIR 55 a8 EFT ENHL, W) LAAE R 26 Fp kAT il i

To Lk M 283t

FE1: MEPRINAEFERNTLLES, 7] LEES] Internet
o T ETFEAURFT ENHLAS I H A LK AT 2k DO RE ) 2% HH 28 R AE N 45 H o
o UL ETHURNFT BN I o B AE B i Ay b, HAR TS AURFT BN L A 2 .
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o 4% id ik DSL B HL 25 thilfd R 28R 2 Internet.,

o5

J

HE2: BEMLE, 7] LEEZ] Internet
o T TFEAURFT ENHLAR I TC Ze e N\ T BTG 2k % HH 28 IR AE M 45
o JoZRAE N Sk DSL B LA A E 28R Y 25 E 2 3 Internet.,
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FkE3: LM%, AALLERZ Internet
o UFEHLAFT ENHLME I TC 2R N BB RAE L
o WL ANREERLF] Internet.

iy
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7 4: THENEE T EEBFTEINL, AR LLEEZ] Internet
o TMENLEEIERBFTEINL, WAl L A% .

o XFhCE JTVERRAE Ad hoc W45,

o WL AREIEHR Internet.,
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FE: KZE N R LR — N Te M 4 Rl o T ZE 4617 1) Internet, 4#8i%E %3] Ad hoc
ML, ke ) Internet.

AT AT BRI ?

MAERE RO L 2% L BCEATEIRUN 3T EDH LA A 2 b BTN I BT AL A MR N ok i B T
EDHLI E L BB

BN R IR ?

LR BDERAE VI SEALA USB 42 AT ENHLS IR 17 4 b o BT DA SRVl I 45 228 el A b 2
LA EAT B AL

1 Hiﬁdﬁ O — e RAE B T SEHLAIAE T USB #21Hh . USB 2 1l ez oSO L I iy iy i i, T
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o L AR
o HEEMER

o PERERIR

o R 5

BES
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BERETRE

TL A N B IR, T LURIEFIBCTCZR (5 o FTEIHLINZ 30 & 00 (145 5 5 8 o e B i AR s 5
oL ARZ AT LU R S . — IR EE ok A HAB A b s S A B T30 53— AR
FEREE . PO IR B B, SR 5 TT BEERES -

FERCEIE R, AT SR 5 o5 th e ST EDHLS A 10 . A TSN 2eke T EZid i
i, JERCAS AT ] RE ARSI R ST A I AN R AT R bR, R A RS TS 45 4
W) TR 5 R

W A S TR, TR TR / SOk & i Bl B B AR R gkt i ds) HLBGL by

FAEWE W o2k (E 5 ?

TEAT EIHUGIEAE R 26 EIEAR 10— WS RS T2 A 5 AR ZE . WERAS 5 K58 RARH B R, &
FEANREAE D 1) RO T ML AR5 o WNRG A E T EDHLZ A5 DT 1) sl B B9 A 5, TS T B 2% i L

e “PUER” FBURETEINUE RS AR S A SR . (U, W RE AT IR B PEROME S o sk, JF H.
BAE SRR &, B EW BRI .

WA R VT A R tha8) RHTEINLZ (8] A5 5 om B )8, 125 R IME T B — AN e Z A

EE:

o NHMfEYIMEIGEH T Infrastructure %%, A B A Ad hoc W4, 15 ZERRHLIME RSO HETT ) 2 i
FELF Lo

* Ad hoc MZ% )55 HIEE Infrastructure W25 /NG 2. WERFTEIHUAI VT SENLZ ] BOIEAE A 1), 3 2l s3]
E1YVIRG P S T i X

B Eh4T BRI 2 BE 38T V5 ) /<

WNAATEIHUBS U5 1) s R, " EREANRE S 2% L A BE S0 A5 o X R 2 B o2k &%, Usin) si T AL
Z IR B KRR R0 100 Je 0 (B0 oK) o MR W £ A Jry M1y 1) B B, b i ) DA SE A BB A

BRI iR ANET ERHLZ 8] B b4

R ETVTIL A B L BRI K2 Bk, KA SERE . HOBR, K EAILA A KA R LR A 5 o ()
S ASEBPRIRIEAK, KURLE S, WS SR RE L0k, AR L, AL
BESE S LR

B TILIR
FA SRR R JC L AR W] R B 2 EIRITCEAT 5 A, 3 B ARLT- SRR B [l FR 9T B )i
o SCHITRER)T-HKIE.
o IR IS FTENIN, TSRS . e s (EEREEEA R o BLIME, LT IE R
[ s e e, TSR MR B S AT FI LR
o WERA T — AT M B AEMIIIE e, B LD IR 5 b A JE A IE
o THIPRYT ) RURAEST EDPLEO AR A it B BRI A TS 5.

RES
75



A1 B M 4% LAl D15 5 TR
HMEC Ll S el ik, WS fifrmes. MRS KWK, BB, Hodls sl vk
I, PR SR > AR 5, I HASLE SR R AR AL 8 22 1T 3 BSCIE A i J. A0 ) UL AT RETR
FEE N R, DA RS 5 TR

BIMAT A BRI T E AT EVHUERAE R — B & Mg+ ?

UERAT BRI SENUANAE [ — AN e 2k M2 b, R ANREREA T AT B, AT SNl DA AE R 2, 4T
EVHLIY SSID w2l tH ML SSID —E.

Windows F /°
1 RIS B M 45 1) SSID:
a TFEIEI I T Y oS A R N TSR N S CeEei th#3) 19 1P Mkt

TR IEA TGN S P Huhk:
1 9 @, siEnd “FFeR” , RiGsd “iBIT7 .
2 7 “TFIRER” B “i217” HE N emd.
3 % Enter #, & i “Hhe” .
4 i\ ipconfig, JR)51% Enter 8. &F “ LM ER" XK.

* Default Gateway (BRIAMISC) Il H il RN R
o P thuhkth 4 HECFA R, HANES 2 TF, Bl 192.168.2.134.
IR, WS P AR .
iy “He” .
1E “TedeineE” X4k SSID.
id% F SSID.
HE: WHFANEHEfHOLS T ITH NS, B8 KE 7R,
2 RIUFTEPHLIT L (1) 9 2 1) SSID:
a MATEIHLFTEN—ak P28 i 0.
b 7 “Jk4” Xih#{k ssIp,
3 LRI EHAETENNLE SSID.
W SSID A, BTN URIFT EPHLE A R — AN M 4
W SSID AHHIR], 15 FE P T L s N, BTSN 1 JC 2 N 44 b e 254 T ERH L

{#H AirPort 235 Macintosh (FE3CfR) R

Mac OS X version 10.5 Z.5 & IR A :

1 M\ Apple 5 HAR R IE £ :
System Preferences > Network > AirPort
VHEAUITZER I M 25 11) SSID ¥4 .7~ 7E Network Name ¢,

2 x| SSID.

®O Q O T
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Mac OS X version 10.4 B.5 B IR A :

1 M Finder " & IG%EH

Applications > Internet Connect > AirPort

THE NG 45 (1) SSID 2% B /RTE Network SgH T,
2 idxx | SSID.

i F#: N\ A Macintosh (GESCAR) 7
1 FERE R DT YOS R R A s NBEN RO P BBk, SRS AR EEREAT AR BR 2.
WERAEATTE N R 1P Motk 4% BECL R 2D R AT A
a M Apple 3P UCEFE
System Preferences > Network > AirPort
b #.ifi Advanced 1 Configure.
c i TCPNP.
Router (% rH#%) T H & B B N Rl
2 IR, IEWMAEKIH P A ER, R )5 OK.
3 1E “RZwE” XAk SSID.
4 %k SSID. AR MA WEP %4 / WPA %4 (it 2 xiif)
HE:
o IHMIANEHEM LS T MEE R, WK E TR,
* 1% SSID il WEP %% / WPA B P RAEAE 2 A7, LA RAE A .

T AR IS USB 40 W) 48 45 HI AT ENLIE ?

o ATEBLSCRE I () USB XE BRI E . T ETHLAT LU BL R kAT
o KHuER: (] USB iR SThL 1D

o LI

o RN I B A 3

H4 2 MAC #ihl-?

BEARDT T P (MAC) i It it 5 199 2% e 26 (KR AR IR — 4> 48 AZFRIRST . MAC Huhib thh oy Yy Et i, RobE
LA, AR MAC MUl A+ N ikl s W, #0h: 01-23-45-67-89-AB.

BEARAT LA M 2% e #45 1) MAC Sk, (BRI AIXFE. Rk, MAC Ml o 2 [ AL 1P HhEfR
BHEAL, Pk MAC itk YU W9 25 Hh g i e (10 S TSR K i

AT 22 42 DY Re A b 2 ol LAREDE R 25 1) MAC Hiuhik. b D g ] DU VR s U i) 4%, efi1r) MAC
HuhEROA, AT LB LK B AN E B A DT 1) ARSI 2 AEH] T MAC hibid 38, S B JORE T ENALIY
MAC Mt N 21 SeVF i #5113 H
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Flnf &k MAC Huhk?

R Z 2B HAT— AE— IO REAFUED,  F T FIR 28 o 1R A B & X 93 TF o SXBR A 21K L7 1 75 (MAC)
Hk.

REAE M2 P 2B TENHLIN, TR SE T A 1A MAC HuUhEFIET BN
MAC it bR A7 T-4T ENHLIR HLif

WPRST B S5 4 ) MAC it — R AR 7o AR B A I ] — bkl 22— &7 2040 11 (UAA)) MAC
MAC: XX XX XX XX XX XX UAA: XX XX XX XX XX XX

Hidk o

HE: BT S (B tds) B E—A MAC Hilibg113%, H i MAC Hibib A4 ) B & A H I 4% o 3X R
H MAC 245, QUREHEGBIEA G BRI T MAC [ jEThae, JF HAER — S fTENPLAS IS M &5, STETHL
(¥1 MAC $htit 2545 5 MAC Mtk 5113

o2 P Hihlk?

IP ik 1P RIZE b (R e (BIIEEATEINL. TFEEHLEC AN 1D P — A — 150, T HAE
PEAGE . AT 1P WIS s AT ME— HATRUT IP HbhEl, B2 (A v DLEAHIE W Pl 1P k3R
INAE[R AN RIS AN AT A BEE A A RN 1P ik

IP Huht il 4 2HECF ALk, /NS 40 JF, 11 192.168.100.110.

H2 2 TCP/IP?

W26 ] LU TAE R TSN 3T BN A e 86 mT LU o 2 ol o 2eA5 5 AR AR Bl . — A RR
PR A R T LU IR et A S o T RE . BT DI A — Rl =, JF HAE SR, e — &
IR LA fe R 2 53 AT R

RSB AL A RIS, AR 725075 d i/ P9 B (TCPAP) 2 d i I ). TCP/AIP - FAE TLIK AT
K20 w) RIS BE I 288 Hh R IE s

TSR ST, RREIKEE R 34T IR, PRItk TCP/IP 25K M 45 v firy A Fl TCP/IP BEAT I TR ¥
F Wb JAT—A> IP itk o 1P HUhESCRs P B i U e — Tk LA AR, e g b AR i . 1P ik ] A
FEVF TCP/IP A {99 2% Hh 1) 48 Aol e 26 1E AT SRR W K dfs
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I E K IP Huht?

Windows f &
1 s @, SR “FFR7 , RFHd BT .
2 15 “THRIR” 8“7 HEPHA emd.
3 % Enter f#, siF Ml “HE” .
4 i\ ipconfig, #RJ5{% Enter %,
IP Muhlk b 4 208074l HINEUR 2 JT, 6140 192.168.0.100

Macintosh (ZFEICHR) FH

1 M Apple Sz H Ak ik £
About This Mac > More Info

2 7t Contents [ 15+ #.5 Network.

3 R IE I To e R TIEE R, 1 M Active Services %13 L $E AirPort.

BEHRITEIHLE IP kit
o MATENHLITEN—5K M2 BEE T
£ TCP/IP X3 b A 4k “Hutik” o
* HEHEITHPLKE.
1 EFTEIHURAR AR E AR
%> NERE > TCP/IP
2 ik ‘e Hubk”

IP Hihik & el g e i ?

P 3t i m] 56 Hy 9 248 78 EHL BCPM(DHCP) F B8R E » 3T ENHLAETH L 2kesg e)a, TR &40
JITAT BT A 422 FE b e et o 5% 32 B 9T BB o

R P MR AshiRE, ARG ERET, AT FIR P S T ENPLL o & BRI Tl A
M B A ICAR R 2% 45

2R EHARS!?

—MEAR Ll w0 LIRCE 4 > WEP B8] (H, & RAEMZ T R — Y. #YlHa
—ANiS, EYPIRG SRR T A S ERCE T2 WEP BN, o2k M4 i P f e A
MR BRG]

FERS BT EDHL B P AR f_EAE TR — S 2851 .
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YEFTENHL

Y ITHI RS

B T LN DU RIAESS LLAN, I RS (3T EDN LR AE v i e 1, Bk Jefg
PURF S IR T2 RESRR S, BA IR T O CInR B 2ok .

BE=KE

AT EHLERAE TR

1 3T EDHUBRAETIOAR 119 2 $.«

2 AL kR e A i @ g
3 Mk @ ik EBEBKR

AT ERHLE A

Windows f /

1 sl @8 “FFER7 .

2 il “PTARER” 8 “BBFR”7 , ARG WFIR P IERET EIHLRE P S
3 i “4TEMPLER” .

4 NATEIHL T hr 8 R ik B 4T E L

5 7F “Yi” kiRl “BFERBKR” .

Macintosh (ZEICHR) FF

1 7& Finder i EXGHFTEIHLSCAR %
2 AR s Printer Utility .

3 7 Maintenance 11~ h A a5 /K o

FIEAT Bk

SPAT IR A B Y R FTED

URAEFT BV G 1) 75 Bk 2% LA AR ReIR - 8] RE A BRI EAT Bk

5 AT ENHLERAE TR
LIEN 8 E
2 AT ENHLERAE TR LA 2 $d

HEFITENHL
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3 A BN gy A B e

4 JSI4E BOR SRR CRIEITEINL” . AR5 @ L
FTENHURG AT B 5RAZ IE AL
W AR IFROEI L, BT E SR

AT ERHLEAF:

Windows f /*
1 A EEAR.

2 i @ “FERT .

3 il “PrERER 8 BB, SRJE SR R EDPLRE A
4 B “YTEINLER” .

5 MFTERHL T g ik P8 i FTENAL.

6 & “YEy” EmRh R “RIEITHIRE” .

7 ISR LR ST R .

Macintosh (ZE3ChR) AF

1 A EEAR.

2 1t Finder s B AT ENHLICAF I .

3 FZEH i Printer Utility .

4 7f Maintenance £ Jii-< H ¥ Print Alignment Page.

5 SN TR ST AR

URAESE D T BT BN BRI R AT B s, R EDFTT NSRS . WERFTEN R A 1, TRV TE SR &
Mk

RYLIT RISk Sk
T BTGt ZE IR At T EISKIE S 3 0 o R BN S T LA R 6 04T B
VER:

o THUEATEILmE SR A 857K, PRI R AR 2 R I s A T Ut
o WRIESHVER ST 2 1 a8k, Uil BE 2l “IEVEITEN SR ke Il, DAY SRk
o UIARSKERAR T, BUE AT R 88 G, AR5 A AT s DT B ki k

5 AT ENHLERAE TR
1 3T EDHUBRAETIOAR 119 2 $.
2 A BN R AE e B

3 B BN CBYATER” . e G LA
ITEDHLRs 24T B — 7K3G VIl T

HEFITENHL
81



AT ERHLE A

Windows f /

1 sl @8 TR .

2 il “PTARER” 5 “BBFR7 . ARG WFIR P IERET EIHLRR P S
3 i “4TEMPLER” .

4 NATEIHL T Fr 8 R ik B 4T EHIL

5 76 “Yiy” kIR “TBRITEISRE” .

Macintosh (ZE3ChR) B
1 7 Finder S EXGEFTEIHLIC A
2 AR s Printer Utility .

3 1F Maintenance i1k 7 #.i; Clean Print Nozzles.
FIEDHURE 2T B0 H —oRkiE wE I vt o

IR BEIT ERPLA S 58
1 STEBLAOTIR L, LM\ EIT.

Z&%@—%ﬁﬁ@:%%%ﬂwm%%%ﬁ,%Tﬁ%%ﬁﬁ@,%Eﬁ%ZWM%%%@L%F%%
2, JEWTITTENHL LI BT AT HL 2.

2 AITEIHLA HCE AT I 4R5K .
3 IR — BT HAN I B AR A I -
EE—ATREAIIRIR: I B ST AR R s R, U BN RE S BUAT EIFLI R 2R )= -
4 5 FEVESTEINLI AT, PR A f HE ARFT A BRI
BE—ATRERIBRIR: (8 AIRRATTE VLT EDPLA N 0] BE S BUR TS AOST ENAL.
5 TG BHFT ML Z T, EERIAITEINLE A T4

S L YN

1 KK — P BANE R A IR .

2 BRI .

TR EROR SO BB AR OB L2 A, TSR B SR K s IE W & 584 T

HEFITENHL
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o) AR
FERS AR LR 178 2 W1

AP 20 T AT LU R K 22 B3 T EHL ) AL

o I TBIRER) IRERAE ST EINL L, 5 S A vl P e L
o TEHHINT ENHLBATERAEAR AT VM PR 4% . ASTR) Iy LY RS 2

o TEHHIATEINLA B IEEAT T

o UEHAIATT EIALA: [ A L AT EVIR S5 s LA P 45\ i
o MEITEINLE AR R, JFMRER,

o WA RAEE, JFHERRRIK.

o FIEITEISRG, WA WE, THZEOFITEI SR G,

o ARG L AT (RS Windows)

o SCHIFTEINLINI I, S5 RZ) 10 #ooh, SRJ5 SOFTITHTEINL.

st I AR 55 AR OV LR AT BT 19 7

55 L PR TP I I AR A B, PR ST AT BIHLE ST 25 A% ) SRR RS
WIS 0, ST BMEHI LR 5

UG LA TRE (0 “ RO | 1 fik © s TR .

B, WO LT B IR o o <R SRR ARSI FEAT L
R A5

3 i “HTEHLETT

A A R RS D

W02 5] AR B AR R B )
7 ie) AT 1 o T B 3 support.dell.com 74k DL R P 4
o TELRFIARIHF

o HLIGFEORCRFIE R 515

L] R

o 584 71 “WInhE R RS RIE S
o 84 Tl “FIEISLEIR”

® i86 Ul “HMAHE L

o 87 U1 “H4TEMENV AT Ep & B v ”

e 88 Il “YTEHINLITENHE T HIL”

) LR 5
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http://support.dell.com

* 5588 Ui “IT EIHLIC B BT e
* 5589 BT “IGik AT EVBA A h IR SR
* 589 I “JGikiliid USB #EATHIEN”

EoRBE LS RAERIIE S
I PR L T VRT3 FR o i

fERIT NI R ZRIE 5

1 $ATEBLSRAR TR 1 F *\ $241.
SUALHAT SR BRI “BRME” ARk @ et
LTS RBBRIME” AU 1% @ JH.
SUALHA SRR BB AU @ L.
S I ERALEC L

EHZEHASHRES (WREBEMELIHIES)
1 SEPHTEIRLIAF U
VERG: WRMEAE “WCE RO T AN, W O FeHL 3 BB AT N BLA L
2 i DA XL, AR & HHLT T EBL .
VR WOREEMOT O R X e, BB LI RS, R B AP
3 SEMAIAT L

a b WODN

ITEIREAR
WIS AR L BT VERE BT LR, SR TR i
Y HH BT 2 e 4T Sk

1 R OGE T IHT IR o

I LR
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2 QUBATED ko

B TTRREGHIR: R BT ED S A U 5 TSk

3 A B HA R B R B s
* JTEILE

o TEILEY L

B —TTRREOHIR: W5 BT ED Sk A U 5 TSk

I LR
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5 KHHETEINL
TR WURBCE IF FH 2T BN S AN REMR DL 18, TR S8

BATFA e 2

WERAEAE G RE B 2 T )L A FT EPHLAAT M BLAEST EDHLSCAF SR b B8 AR AT BRI S R ST EDRL 3
AT PR TEPR LRI, fn) Bh2 sl S 228 I F Jp 22 e Bk At

P TR ST AT, TSR A 4R
TEHAE T E AL 2 T EIHLERA LI H BN RE TR
FEZIRAT 2 BT i K P Winpows %2727

g USB %3
1 K7 USB S 2R HHE IR, WREEHIA T, EFH 5.
2 ¥ USB HLZ5 B¢ 7 1) — i 242 [l M ddi A FTENHL)E ARG USB 2 HH,

3 Kt USB L4k F P — i 2 [ s il AT SEHLA) USB 45 1
USB #1557 brid T USB 4 o5

R WURRERBCA R, ST SR AR USB . T REIE AR — M s R I B

) LR
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BRI T EIAL R
1 SKPTEBLI M, 48 M H A5 T Rk
2 WTEDHL R R UL, AR TR T IR L.
3 R T B U L, AT T DALY U

T EIAENEANST B B R T
B AR B2 T PR IRAT AR B, A R IR

TEHIAIT BN SR & 2R IR
1 TTFHTEIRLIAAIE, SRR BT

2 EHRIAIT D SRR R R
3T B sk ey IV A2 24 (] i [ 5 AEFT B Sk AR R R A v

3 SKHEH O,
FERRIEITHENL Z |, E7E “FTE1” WPUEAE AP I # S BT EpL
TEHAST B RN B S E

TERAIA RS T ERH LA B BOA ST AL

BRI T EIHL R
1 ST EBLI M, 48 M H A5 T R
2 WTEDHL BRI F UL, AR TR AT EIRL L.
3 R T B U b, AT T E ALY .

Wi T I+ EFE RS T ENPL LA USB ALk

g USB %3
1 K& USB 25 &5 H A, WRBEHIA T, G
2 ¥ USB 25 %7 00— A= [ B AN FTERHLSTE B USB #: 0+

3 K USB L4 F P — i 2 [ s il AT SEHLA) USB 4% 1
USB #2155 brid T USB 47 o5
R WURRERBCA R, ST SR AR USB . T REIE AR — M R AR B

IR 222 BT AT ENHLER A

I LR
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ITEIRLIT I 2 H R
7 [ BT A R IE W 22T B B T 2

HHT R AAT B s R B VR IE AT Bk
1 B TEISR E . WS E 11 00 “EHATESR R RBCEZFEE.
AT B S B EOR A RATIE, TERAIATTED SR 2R R A, AR A JOBT 2l 2 T B s
FN AR
ST ENHLERAF TR A0 = e
FRCELS P Sibun s k= AN S EEi-d O S
I SR LR RBEBYEATEIR” A5 4% B .
ITENHLAS AT B — K DE L
6 SRR CRIEATEINL AR5 (G L.
ITENHLARS AT B — KA E AL
EE:
o IHAEBITRIEMR T, HEFTEISE .
o A EELL I TIR RV
o WIRSR VL5 R AT IR R, TH IR TSR

a b ODN

FTENHLITEE BA Y
WU AR BT VROV R, 555 R o i

TEHAITEINLBCR AT 4 B UR R X

R ABYERR R AR IR, BT ENRLAL T R i & 3l R ghi T EnpL.
BERATENHLAAT IR T A R I, 1 J0FT R sl A«

1 QY e BT iRk, SRJESERr 10 Bk,

2 R YRk SR AR YR AR B, SRR ST ITT EDHLIN R

AR ) AT IRAF A, VDT IR AT s, X T RO ST BB A B

BRI T EIAL R
1 SPTEBLI M, 4 M H A5 T R
2 WTEDHL BRI F UL, AR TR AT EIRL L.
3 R T B U L, AT T AL .

) g 5
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Toik INIT BB B = M ew SCAS
A8 L B A AT EDATUS IR S SLAB P AS REFTED, T SEHURITENHLT A G i

BT E S RN E R =

JovEE I USB JEATH EN
WIS “AESE AR R B VR IR R R, 55 B F R — BB B 7

K7 USB %%
1 Ky USB #2452 5H H B RHR. WRBESHIN T, WHEH M.
2 ¥ USB 5 47 i 22 [ bl AN FTENHLS T USB #2110
3 ¥ USB 45 11— 2 [t df A THET AL USB B,
USB % 1 5%l bnic 5 USB 175 e<5=.
R W RER AR, G ERA TSI USB #2100, ST Reid e — /M ibE e 0 b

ERA Winoows K] USB ¥ 1 228 A
1 At @, SR “FFER7 , R BT .
2 7F TR 8 “iB17” HEP I devmgmt .msc.
3 {% Enter f#, #i#ipd “Hae” .
WA PG L
4 ok T BT REEEHIES T SHANG (+).
W45 F1 USB Host Controller Fil USB Root Hub 41 ¢E 3, 58] USB i F U483 H
TS VU AR OGSO SRICE 2 145 B .

IR 222 BT AT ENHLER A

R BEARE R ) AR

* B89 T “YTEIHLA AL RAL”

* 5590 U “ARIKSIA R AR AR

® 5590 U “XUMIFT EIFRAE N A AR 4R
* 5591 BT “ARGK BRSO R R

ITEIHLA R A R 4K
VERK: TEDNLPY OO A S B AR G R 8 SR RO S

) g 25
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1 45 O AT ETHL.
2 At gt BRI ACR R AR 4.

3 ZERIMAELREK, RIaREtd .
TR B ARTR I AN O AN A AR K o
4 i O T I EIRL.

IR IRARERL
VERE: STEIHLIA RO BRI . R 1 AR 5388 G A8 S S
1 4% & SHLKPTEIL
2 FEREANEAT, AR
VERE: HLHARHRIN 0 AR
3 fk & AL HHT AT EIAL.

SUHIFT B AR A A A 4R
VERK: TEDNLPY OO B S B AR G 8 SRR S
1 3 FBUEHHLIE RO T 5P«

O] R E . 0L T AR I T 0 DX A R AR A (ARSI R — 82D o T
B3, RN TIHERR Rt DI, 3R o

) LR
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2 ERIMAELREK, RIRRE .

TR B ARTR IS AN O AN AR K o
3 HOBTEEAXMAT BV AR

4 fih#i “DONE (58 7 ol 4% @4l Wk TRMITEpLEL S .
5 7EBHITH AL EAREATENEAL.

ARTR BT IR B ARG IR

I RARGK SR IR O ARAN IR L il Ik 2 UAREE RGeS, DU T BRI P k. 1 2l i
R E 2L VIR

KB ARIK AT
S VR 9710 LA S O 63K

AT
o THLEFTEIHLA AN DR (1 485K
o FACIKIHE AT FTEN — %] o CAPREASEM— 1 I 4TEN, W2 RARK B I3ES. D
o THS PR X ARRAVR IR A B PR e 488

il e 8 4T EDAILIE H AR 9T BRI
TR LLE SRR A RIZRK

I LR
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FTEP o) BB 2
o 92 U1 “HFTEN DI AL FT BN AR 2
e 93 Tl “HITEN MG I Ac gk 5k
e 5503 1 “H4TENESE N
o 94 U1 “YFTEIIS VIS AR e

TTENTUAZ AL ATV R BAEH =
AR MR BT VROV R, 555 R o i

KA/ MTEIRE
BrAESEATH JEa St ohe, 5 WHE AR LT i dse N T ER L BR v
o JEilBEAAT TG
— 6.35Letter )] 4tik: 6.35 =K (0.25 9&+))
— 3.37 [ Letter IAMP I HAhatik: 3.37 =2k (0.133 %))
o L. 1.7 =K (0.067 7:))
o [ilfh: 12.7 =K (0.5 %))

BRI AT N T he

Windows f /

1 FITF ORI R, AR AR b sy “ 30t > $TER

R TN b SN A S

3 1F “HTENRE” KRR “4RikiEmT” Rkt “TBlR” .

Macintosh (ZEICHR) H

1 $TIF A, R P b it File > Page Setup.
Wi File S 547 Page Setup Wil H , THEEZRIDH 2. & NE R EEBHFTENBIE :
a J\ Settings i 3z 1% Page Attributes.
b J\ Format for 5t i = i £ 5 14T BN L

Cc M Paper Size i IEF LR A “(Borderless)” 4K T
filn, WEREEENT 4x6 vk, iHiLHE US 4 x 6 in (Borderless).

d EEFTEN T, AR5 AT OK.
2 Mg ¥t File > Print.

RSO AP A HRE THTEIRL. ARKSOIAETED 1R, 7R RIDER 3 20, #ErIfebZi Printer
i HH SR AL PR HDFT R PSR AOAT BN L. 15 IS B X L N 75

a M Printer i H S Lk RIS ST EIAL

b I\ Paper Size gt bk FE AR A AT “ (Borderless)” 4K ).
B, WERERENT 4x6 vk, iHiL+HE US 4 x 6 in (Borderless).

Cc EFEFTEN I,

) g 25
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3 wHVE, ¥ Advanced.

4 JFTEEI S A P R Print Settings &% Quality & Media.
e A\ Paper Type it % s PR T
e A Print Quality 3 Hi 32 §. - 1% $f Photo 5 Best.

5 ik Print.

T ENA BB P HH B4R BU RSk 55
P PSR B2 T R SAT AR, WA R IR s

BHEBKE
S R T E

FEAT ENHLER A P IR R AT N B
TERAT BV S R IR
FIEAT Bk

TR VL BR BER LT B ke K
VERK: WSS A SRR E BRSO, TR S

5

ITENH 18
U PSRRI T R AT AR, WA R IR R s
R E B

o TERMIITA AN IFER .
o JER YN SR R R MTENR R ACR AR
o REMNERGH LA K,

B AF
SR T STHUG 2 1Y 77 (RAM)

FEIT DL I BB R AT B &
F IR RIS I ARTR KA
I 223 BT AT ENHLER A

) LA 25
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AT EIR TR LR AR NS
DL R AT REIAR T o TR

MAREAEH USB R, H=_E# 5 —MR USB B2

WREAEMEZ T, FEFBIRAL BFHEE) KRR
1 AEAS LI,
2 10 BB, AR TR UL

K EVRI 33 4 7] AR

* 5594 U “ITENHLAN A S B B il B AT SN
* 594 U “HMGH AT KA
* 5594 BT “ BN e R AR 2
* 5595 B “ICRERM LR B T a7
* 9595 T “HHHIA L7
* 5595 U “HHIMIE ST AL AR I o) i 2 BOEL”
* 596 T “ ikl & ALY

ITERHLAS RS B B3 8 B A R B
P PSR B2 T R SAT AR, WA R IR s
RGBT AL B N BRIN T EIAL

I 223 BT AT ENHLER A

CEEE NG s Z S PN

1 SRR

2 WL FTAT S BRI TR e
3 KL

SHIEHEER REIEE E
B AR ) B BT T A R, SR LR — R 2 Ry v

3 LY G R
FEAT ERHLER A P R B 1 R

) g 5
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W YA R B BRI 3RS AR s T R &
A5t FH 5 7 b 900 SRS B P B DR A
TEHIASCEEUR F B MRS L, FEAM T IR AR

SO B A R R BB T — 3R>
R AR L2 T R I R R, 55 B F R — B B 7

TERIASCEEUR F BB RS L, FFEATIERR A%
FEIT EDHLBR A i B R AN B4R R T
WA “RAERS” B EBEEFRMK IO R —2

HA TS
G “AEIR M) B BT RSB Y] @, 15 2R LN B e R
g USB %3

1 Kot USB HZi A W R AR . WERASEHUA 1, B —HUBTHY .
2 %5 USB 145 BB B g 24 [ M el A\ T ENALS TR USB $1H

3 K USB L4 F P — i 2 [ il AT SEHLA) USB 45 1
USB #2157 brid i USB 47 o5
TR WERI BRIV SN Al USB 45 11 . S nT REREHE AL — M iR 2 1 L

BT a v E AL

FHRAESTTEFR K A I (7] 5E S BUEHL
B AR B2 T PR IRAT AR B, A R IR

R A EARANH R A
BRI R

I LR
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p/nr U E BE RN )
UL AR AR 2 B VR I R R, R B F R — R B 7 i

VERIAST EDBLAN B 0 S e R — A o
VEBRIALE F MR EEHL b 22 T 4T EnpL R pf

TR SR &

® 5596 U “AEfifi I In) AR R I
* 596 U “HlAALE R JE BT AT SN
* 97 U VA MAF R BN A7 IR S A h REAT AT RN
* 97 U “ IR T M L% NAF AR ARIE I A7

FEHEF IR B B E R

AR YRR BLZ BT, B OV R LA Yk M R
o T IO i FAT BB R

o WA R R SR

o AR o A SRRSO

TANIE I SR AT
I AP R B R ARV, R R IR R e

ERTRAE
AERRITAERI KNS, LB T T AP

g USB %3
1 K& USB 25 &5 H H A, WG HIA T, EMH—MH.
2 ¥ USB 25 47 19— A= [ B AN FTERHLSTE B USB #: 0+

3 K USB L4 F P — i 2 [ M il AT SEHLA) USB 45 1
USB #2155 brid i USB 47 o5

R WGBSR B R, SR TSR AR USB i 1. fnT REIE AR — M s AR B

o 7 Y 2% JE 7

DR FTENHURIH SN AR IR AE R 28, IS WA A AU & R AR T TEAE TNl B BT L £E
FTEIHL e PEvt- 5L

) g 5
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Toih WAF iR BN AP 3R B 4 P BEAT 4T B
I AP AR B R AT RO, R R IR R

K7 USB %%
1 Ky USB #2452 5H H B RHIR. WRBESHIN T, WHEH M.
2 ¥ USB 5 4 7 i — i 22 [ bl AN FTENHLS T USB #2110
3 ¥ USB 45 11— 2= [t df A THET ML USB B,
USB % M 57ilbric A5 USB 775 <%=
R WP BRI AR, SRS LA USB 00, ST Reid e — M ibE e 0 b

o 7 Y 2% JE 7

DR FTENHURIH SN AR IR AE R 28, SEWR AR A AU & IR AR ] TEAE TNl EIEBT L £E
ITEIHL e BEvt- 5L

p et ALY S v e
I AP R B R AR, R R IR R e

TERAIT BN B R AL IR ER BT, R HAE S e
MATEIHL_ LR3I P i # IR v LA

TETHINE I To S M 2% DR IF Bn] DUEH
WA I T AR R T, 1T USB MU Bt T EDBLR AL

To2k 7 A fiE &

* 598 BT “ILk i A E E I
* 5598 U RIS BUE MK M) ERIN IR
* 599 T “ ikl JoLk Mg AT T EN”
o 102 5T “ “YREL” HH CIRER]
* 5103 7 “ICIEFTENIF HAF SRl 22 7B ki ”
* 103 UL “Wi-Fi fmiTAse”
* 55103 5 “Wi-Fi fien k2 2kt i, (H24TEHHLATE (R T Windows) ”
* %105 5T “Wi-Fi /s AT 2t i ”
* 5106 7 “AE AR, WI-Fi fiR AT N SRR ¢
* 110 U “BA LATCLATHIR S5 4% 7
* 110 0 “ T RLATEIN B “ I HE”
o 12 U0 “ IR PR N2 (VPN) I 54T ETHLIR G A i 77
o 112 BT “fiff Pla] a0 L i i)

) g 25
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TCER 1] R AR B B ST

TETFURTCERFT ENHLIN In) SRS /T, WAL S S 00

o FTEINL. THENURIJCE N i #HaE iYs, I HrIR CFT T,

o TR M4 nT LLUER TAE.
AR U ) S5 1) JC 2 N 4% HP ) A TSR L
DR F M 28 1] LT ) Internet, 115221800 i 1 2k% 9% 3 Internet.

o {11 SSID J& IEHI .
FIER— ok P 2% B & DR B 4T ERHLIT A A () SSID.
WA 2 4510 SSID &R IEM, BT T L&k E .

o 1K1 WEP %4k WPA 4 1E IEHI (WIS 451 22 1) .
BRI S LRI HES) IR A2 E .
ﬁi%g%@?%@oﬁ*ﬁ%%@%¢%%ﬁ&%(ﬁ%%ERVWA&WWQ)%%%%*ﬁW@%
YA
WA I 5 S IEM, 6 Rl T L& E .

o FTEIHLAITHSTHUAT T IC LR M 4435 il 1A o
Efﬁ%ﬁ@%*%,ﬂﬁﬂﬂﬁﬁﬂ@ﬁﬁ?ﬁﬁ%%%Aﬁ(%%%m%)mo%ﬁﬂm*)HW%
7o

o Wi-Fi #8741 525 IF Hogartarm.

o ERSEAT AT ERHLI VS b 222 74T ETALEK SN R o

o RS T IEMAT NG

o THEHUNFT ERHLERAE A — A Mg .

o FTEIHLZE & ] Ae TR0 L5 5 M BE A A B HL 15 % o
WA ST ERALANTE Ze e N il 2 RV A 5 4 DR R T AT A L B RE BN S AT
IRZ WA LT IR S, WiFEJLIIAS . KWl L&, 2 RGEMAHNL. AR IR M 45 Fl

IR

AL EERZ AL BRNEE
1 ST EDHURAFTIAR LAY 2 $241L.
2 RELEN SR “RGRR”  AUE i @ .
3 IR ALY A PAHETTARNE h BRI L AR B L
8 STHA AR “R7 . A B L
FT B BB AT ) BRI B LT B 3K 4 B B ST T A

) g 25
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TR IBIL To Lk M AR AT T B

SRS 2 B R T L (S HOAT DL AT BRSO, SR AT N ST E L
AT BLAEAT EDBLIR I, 65 T LA 2 2 M T 2B 1o

(LS TR R LT, LR I AR RO, AR5 S5 0R Bk R I Ty ik

RKEAFHEFITITERAR CCLEE )
S A SR, AT ENHUAT VST TERTRR S b . MR T LRI 940 8 BT A e i .

MU AP 2%(VPN) 7 T332

M VPN R A AR 2 i, R A REAERS I M 2 R A ST EIHL. TE A A VPN, SR H08r
FARITEHL

WA “ERER B

2 CPORBEN R, T ETHLI A TR
FEAT EDLRAR TR L 1K

> BREER > 3 > (R

AR K WEP 50 WPA %4
RSB AU WEP 5e40bE, WEP 5910400
o 10 26 M PNHEIFAT, TG A -FL a-1H0-9,
2
* 5ok 134 ASCI 5. ASCII FAFUFETRE. HUTAIM LL{ERERE 4RAIN 71 . WEP %911 ASCII
FRRER KA.
RSB ST WPA 50 WPAR 540, WPA BHI 200
o 64 [ NHEHIT AT, [N TR AT A-FL a- 109,

o
o 8-63 /1 ASCII ¥, ASCII FHHIHRFRE. KA LIZEHAL EARFIITAE . WPA 53l ASCII 5
BREX SR,

EE: WREAIERER, WS MR B3R AR Bk, B 5 2 o 4k 44 1N D1 Bk
3

REEREAN R LRER R / HEMEE

FERRIN S PR AR, S 1 BT e 25 TR s T EDBLIR,  To&k wiair box (i LiveBox. AliceBox.
NOUF Box. FreeBox % Club Internet) nJfg<s BRI SBE / 1 WHE 4

USRS I box HFR BB LM 8, 12 MBI box U HLIMBYCRT, 80 5110 Internet
55 B (1SP)BE R -
BENER LR BN R, 2 aBHAhE i
B TR BRSO B, B LM S RGHINL) TR I TR
ST DA A B LA B B e 6 (A )

R
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Revh EAUR / BT EIHLS 3) B BE B N\ R EL RO 3t Ty

BRI ML RGO TR Z R, WA RHRA RO 4G B AR RE ) o AR IEAEST BN 2 ), 1
AR RETH SEPURSTENHLI AL S, A (T2 e (8 AN 100 9e .

RELLFESRE
FTEN IS B IO FR B (5 5 . BRI O 3 R st I, 00T 3 S0 ) BRG  SLAR B 2

REEN AR RERE
o WUERGEEAEH MAC CBEVRDT Il 750D Hubikid 8 T ek BRI A A 8 1 JC 2 RZ (DT 1), Sl 250K T BN
HLI MAC Sl 73 In 2 af DOERE B Uit s 38
o WURMREERE RN SO BRACE 1) 1P Mk, A5 SUR I, AR A R g T EIL
R WREA T ATHTIZ AR, TEZS R R RS B SOk, o 5 2R T L 2%
PN

WHIANERTHENERAERRERA R L
o FTTFASH I TUI YL B U AEREI S, i B R AT AV ) Internet.
o WnSRASH LI AT LA SERLSR U, PR E B A 7 T LU VSR LA

VTSIV LR TR B A — A T4 s

UERATENHUAITE SEHUANAE [ — NIk M 28, B AN REEI T AT B R SNl DA R T2 M 45
ITEIHLIY SSID 2545 5L SSID — .

Windows F /

1 SREGT LIS M 4 1) SSID.
a  LERSIR I B B R R E A A NS IR N S 1P Stk

WA FIE N ST 1P Rk

1 gk @, 8 pad “IFeR” . RGd “B177 .

2 18 “THRHR” B “is17” HETPHIA emd,

3 % Enter £, sl “HE” .

4 i\ ipconfig, RJ51% Enter #., &F “TLEMLIERE" X .
* Default Gateway (ERIAMISC) i H il i RIGFEA £
o P Huhkth 4 HECF A0k, AR IF, Bl 192.168.2.134.

b MHISIRES, AN S AR,
c il “WE” .

d 7 “k&E” X &k SSID.

e idx I~ SSID.

EE: EEAGHERC R T RN, O8RS R
2 REUTEIHLPTEE LK M 2% (Y] SSID:
a MITEIHLITED 5K 2% BB L.
b 7 “Jogk” XAk ss1D.

) g 25
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3 LRI EAHLAETEIHL SSID.
U SSID HIF], BLWITHEHLRIT EDLERAE R AN eZe M 48
W12k SSID A, E BT Ie T L BEE N AR, AE VAL A I Jo 2k 9 2% i 22284 T B

{¥F AirPort ZLu5 %) Macintosh (ZEXChR) FH A

Mac OS X version 10.5 3¢5 &5 [ ERAS
1 M Apple S5 R IRIEFE:
System Preferences > Network > AirPort
VIS ER I M 25 11) SSID ¥4 .7 7E Network Name 2L,

2 idxt [ SSID.

Mac OS X version 10.4

1 J\ Finder FP4& /0% £
Applications > Internet Connect > AirPort
THE ML &M 45 (1) SSID Hf2x 7~ 7E Network S,

2 i3t [ SSID.

{5 ¥ S ) Macintosh (ZESChRD) F
1 ARSI Y G0 2% B A R AN S 1P Mk, SRS ARERiIAT DU 2,
WHRIEAFIE RN S B P Mk, 35 3% B8 DA R B0 R4 T 0 1 «
a M Apple & HAR IRIEFE -
System Preferences > Network > AirPort
b i Advanced o} Configure.

c i TCP/IP.
Router C#fH14%) I H % RN A AL

2 YIRS, RGO 2R, SRS Hd OK.
3 “LLwE” Kb Ak SSID.
4 g F SSID. AR WEP #4] / WPA #H] (IRLERINIE)
FE:
o THMINIEAES I Id SR T MR, BIEREFEE.
* }% SSID Fl WEP %41 / WPA B RAFAE 2 A 7, Ak RAE

EHIA B RIRAE RS S T ARPoRrT ITEERFTEN (fXPRT MacINTosH T3
79

FIERHL I SZF57E Mac OS X version 10.5 5 & hicA (Ge3Chi) Hidid AirPort b 8E47 kT Bl .

) LA
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“oker” AR EH
HEIUT SR FIORRTTE, BB “AREE” FeHIZE m IO ELT B il

K fr USB H 45 2 75 22 [ s B e v VLA T ENFLAY USB #: 0 1k
USB £ M350k 0 17 O™ 155

EIHIATEIRE R, HFHRECITIT
B & BHUE AT LA . I RSRIRT JFTEIRL, 6] A SEIT T 96 TR HE USB rh.

EFIAENL LK USB B0 e] UE
ML PO 46 0T USB 501 S RT BLAEBE 1 e M P ECAR B D361 LA
WIS 1R USB B ORREEA, 2 A THSEHL L AR USB 1.

HHHIA USB HL 45 A] LUMEH
ARG USB s, SR 0 A 8R0S T 10 BER, 3% WA B 0 P 2.

WIS R EH TR S M IEf Dt
FLBOAE 4T ENBLAL S RIT EDBL RO 5 o M7 Rii% e AR 8 18 TR 251,

UWERIEATARMTSE ], T AFRATHI MG LN BEOFT A (3T EDPLIA . WESRBCE 2 15 &, i8S T
R LT BRI s AT DU A T2 e SR H A B R WA T

BB AR
1 KT LI R
2 WL LT AL
3 WATELIJR T FUHERLes, 5 THA .
8 LR TR LT L
5 THTIFTENLRA, AR IR T SEBL L kit

IR EBIBAT R
1 KRR
2 WD SEEHE S SL
3 WA, AR EHHET R
FERE:
o HEHENE] “ TIPS, HIAEEE T “RETEAL

o MERHEAS] “WEBHHITEING? 7 FUfint, WURECS 2 THIITEINL, E ks “ HibritE
HL” Bk ik 22 0 S,

) g 25
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REZRTTEIZG% IR USB #10 L USB 1&3)

FIT A TS, K2 USB #:10 FifER: 7 USB WA I 4 B 28 L A BhAE

1 9 @, sliEnd “FFeR” . R “iBIT7 .

2 F “TFRHER” B “E17” #EH %I\ devmgmt .msc.

3 % Enter #, m& i “Hhe” .
WA IS .

4 75 USB 421 Fi%$; USB W g s Hofth (¥ 4%, [N LB 48 A7 BB 70 1. Y4 4 A BB Y USB %
BRI, B RS .
o IR PISAIE, HRE DL ETVEEASGERR i) B, R R BOR SR L .
o IRV TIIEE BIE, TSIV NS [ USB SCHEG 10 8. W4T 2238, L

ety iR USB 4%

AT EIF HE RN L2351 B kI

$=J5 (4F Microsoft) [\B7 K&l RELx TIALATEN . W RAT ENHURITH SN LAR L & 1R 4, JF HIACZ 25T A
IEH AR, ERATENIIAREREAT IO EATEY, FIRE R KB e A RSN b 2eke 115k B% (B Windows
Bl KA LAAR) U L Al el b5k

o A 3 TR B AL BB AR T G R T s KR o 35 2 B L ) 45 P 95 K s RS BRI 3 B SCRS T A ] 54
o AT EIHLECE ZRIT BN, SR 1) B KR SR VT IR), A VIR e AT .

o I EE B K, ARG AEVH ML B2 R dTEIRL. Mg e 2 Ja,  F0Bra B K.

Wi-Fi $E8 T AR
K2 B YR

IR Wi-Fi fos T A, 5N & SR . R O foRIT A, ERELIT A
o THHIATEIHLRGE I, JF HARESTIT

o TEAIAST EDHLIE AR A R A4 AR L

o WURITEIHLIE LA IR AR b, I HIARZAR CATIT, JIF HoaT BLER TAE.

Wi-Fi f875 4T &R, EEITENIATE ((XRT Windows)

RIS O A5 T ICEAT BN S, JF HPTAT s B A IER 0, (EETEIHUASTED, 3§ 2 U R [ —Fhel 2 fl
Jiik:

FR LR
WRESRATED, B Ot SR IT b, HAUEAE LA JH.

) L g 25
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J& FFTEIL
WHAITEIPLE B H
1 A @, S Rd TR, R BT .
2 7F TR R 8 “iB17” HEPHiIN control printers.
3 fZ Enter #, =¥l “HAR” .
FTEIHLSCA IR e i
4 LR EINLIEIRR, AR SE s iy < AR BRALATEIAL” o
5 KM “HTEDHL” 5L “TENHLAMEIL” &1, SRIGHFaldT .

PEFETCLATENHL
REPT RE T SEAE R BTSN LR R ST EILA T LGS AE I HT ER AL
1 At @, SR “FFER7 , R BT .
2 7F TR 8 “iB17” HEHHIN control printers.
3 fZ Enter #, =¥ Hd “HR” S
FTEIHLSCAE IR o i
4 LA UL ARG, JF G «© (M8 7 FRERSTEIHLE bR
5 Mapthsg s iy “fE FHBRPLITEINL” -
6 KM “HTENHL” B “TENHLAMEIL” 0, SRJGE T al4T L.

ks /s A
T A DA 4% FEA B2 (14T B L2288 1 IS OHT ENHL,  RnT Be 5 Bk I 44T ENALA RT LGS AT HIFTERHL
1 At @, S Rd TR, R BT .
2 7F TR R 8 “iB17” HEP I control printers.
3 fZ Enter #, =¥ Hd “HAR” S
FTEIHLSCAE IR e i
4 L AT EDpLIEIbR, MBS g
5 il “¥gH” I,
6 HRFHATH I o ST H AT ARl
7

U SR T R IR X R e A USB i L, 1 ABIR TR R CHR 7 XU T EI L
F7 s e Gk “ATEIHL” DX 3T ENHLAL S, BIA TGO T IERA 3T BV D LS 1

8 il “WaxE” . W HH T EL

) g 25
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Wi-Fi $5754T 21

1 Wi-Fi 3878 KT W RE IS, T RER ST EIAL:

o AT LE Infrastructure B N HE/ T B

o IEAESEA S I o Z v ek ST Ad hoe 1

o BATHERA IO S M 2%

FIEIHLAT BB T BE BE B o gk e N i Rkt 28 ) NG MV A M4, 5038 T E U T Bl & .
AT & W] eI T v o 1S e () — Pl 2 Fho7 k-

T2 199 2% 44 B

TR 1 199 258 AT 1 AT A PRI P A P 28 AR TR PRI A2 B o 9, SRR PR 08 Jos 8 T A3 7o BR A 1 1Y
AR, BENFTEIHLAT RE S IE R R A AR S R P 25

UERIEBAT TEHIME— I8 20K, TS PRSI AR R R has ) AOFEBY SRS T et o] e 8 M 2% 44
Mo

WERTEBEE T WM A FK, B ZUR AT ENHLAITH S SSID HBr B &N [R— A 2% 4 F

fEZeEwmY

MR EAEH WEP 22414
AR WEP B9V 1% 4 -
* 10 Pe 26 DN H 74T TN PR A-Fo a-fM0-9.

27
* 54 13 ASCIl 74F. ASCIl FHHUTE 7 RE. Ky Mrn DL B b 4R 3 1 745
IR WPA 2241

AR WPA 2N A «

* 8-63 > ASCIl 74f. WPA FH] () ASCH 74 EIX 73 KN
2

o 64 N HoNBEH AT AN T UEA-F a-f10-9.

WERIE I TCL B B T i ft, WA ST 2. BATAHER A HIZ R I 2, Doyl
PASOVR AR 5 AR e 205 ARV T Ao 85 ) 0 245 B 5L

RSN / SETEINB S BIBEE EZEA 1 ek hias) HWEIT Ty

802.11b 1k 802.11g I 45 H (1) ¥ 2% 2[RI R EE 2 m] LIS 21 300 e/, 1M 802.11n 19 44 1) o 4 94 £ i [ ] fig <
g IR Z ML R HGR TARZ 3, ARG R0 Eh 25 R P 45 IE PC AR I RE T o A SR AEAEF T B I 3] i)
A, AR EE T S NS EPLIGAL &, A e A2 (8 (0 BE 2 AN 100 S8R,

1T LAAE R0 28 a0 D e 1 2% 45 5 5

K2 MAC #Huhl:

WS R T MAC sl g Th e, HHVKETEIPLEY MAC Hulik s n ] MAC Hulikd ygg &, w]
CASSVFFT EVHLAE P9 28 A

) g 5
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fER RS, Wi-Fi 38R 4T N

4 Wi-Fi fFopdT IARRE (T, FORHT EDBLE Tk B L, (R TR L SRR FLT EDBLIR IS . ATEDBL ]
ARl T4t BB AR A LR 1178) KB TR 4, S0k i S TENHL L .

LRI IR i

AR R YR 2T IT

TR ERA R, WA RE, TR .

BENEHIEA R, PMETIE/D

Fofb B g% (BIUnflep s AR B TEdofiihi . 2L 2 e RGN rTse S Bl 9. 9
BN R TBCE AL PR B X SE B AR AT g T

Revh AU / BT EIHLS ) B BR B N\ R EL RO 3t Ty

802.11b 5 802.11g W £ H (1)1 £ 2 (R I EE B i) LUIA 2 300 9 )], 1M 802.11n W24 1) Jo £k M 4 Y [l vl g 2>
e o S TCZ M2 FTE IR TR 2 R 3, AHEIE I N S C 2R I 4G HE A8 IR ) o A RIS AEFT BN
)8, T A N T EDHLAO AL, e AT 2 A B S AN 100 98,

AT LAAE R0 28 0 0 e 1 2% (R 45 5 5

B K WEP #HE WPA 4]
HSRASHOBE N AU WEP 24t WEP 5940
© 10 /e 26 M NHEHIFA . AT EE A -FL a-fF10-9.
2
o 5E 134 ASCI 745 . ASCI FHHLIGFBE, BT AT AL EARFUN T4 -
RSB A LT WPA 55 WPA2 4otk WPA B854 0
o 64 M FNHEBI T, NI TS A-FL a-fA10- 9.

i
e 863/ ASCIl 1. ASCH SHHUIETRE, B3 AT L/ERLE LHRFIF7. WPA 91 ) ASCH
BRSNS

EE: WREAIERER, WS MR 4B A Bk, B 5 2 o 4 44 1N D1 Bk
3

K2 MAC #Huhl

WSR2 AE I T MAC il gEh e, HHYKITEIPLAY MAC Hulik s fn 2 MAC Huikid ygg &, w]
BASCVFAT EIDLAE R 5 . 1 235 78 U0 “ BANFI 4k MAC Hihik? ™ SRHCEZ 115 B

) g 25
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fEH] pinG AR R, BAIARIZE BT LAIE & AR

Windows F /

1 SR SO 1P HuhE.
a il @, sl TR, R “B1T
b & “JHAMER” 5 “ia17” HEPHIAN cmd.
c f« Enter ##, s “Hig” .
d #i\ ipconfig, SXJ54% Enter .
* Default Gateway (ERIARISC) Tt H i RUMFEA S
o P stk iy 4 ABCAA R AN EUR T, $iltn 192.168.2.134.
2 {fH Ping fiy 2 MliE N\ A
a il @, sl TR, AR “B1T
b & “JFHAMER” 5 “ia17” HEPHIN cmd.
c f« Enter ##, s “Hig” .
d AN ping, — T, RGN SN P Mkl .
ping 192.168.1.100
e i Enter f.
3 KA AT Bl
o RN RAFN, EKSEDUTLL Reply from (M5 HD TFLSCF,
AR T BN e TR W 45 o W5 O 0T B T EIAL, ARG F R 22 il 4.
o WIRANEEAIIN, ¥ 2E ] Request timed out Gk ) 7.
W SR LA NI
a iy @, Rl IR, REsal ‘BT .
b 7 “JFHHEHR” 5t “i217” HEHHIA ncpa.cpl.
Cc fi% Enter ##, st “Haw” .
d MR IFIR P IEPEIE MM IE R
e fikpaliiEd:, REHl “BR” 5l .

Macintosh (ZEIChR) H M

1 15#6IA AirPort £ H:
M Apple &5 oK IGEFE -
System Preferences > Network
AirPort JRAFE/RIT M iZe 2 (1«

) LA 25
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HE:
o W RIR T H, (HE B E.
o LI RN AR E .
RIEN 1K) 1P HiuhE:
a M Apple & HAR IRIEF
About This Mac > More Info
b 7t Contents X1+ .t Network.
¢ M\ Active Services ¥1|5& H11%E$¢ AirPort.
JEFF X Ik A T AirPort EFE RN E B .
d i3 T Router (Eh#s) HiH.
Router (% rh#%) Tl H i # BN .
i Ping i 2 A FE N A
a M Finder H & IRk $¢-
Utilities > Network Utility > Ping £ i<

b 76 R gk D i NN S 1P Mk {5 -
10.168.1.101

c i Ping.

RGN A RN, SR E BT, Bos WA RUHRIBCRIIN 7 8 IR T SR L A4k
Amit.

UERFEN AT BN, AN BT S #8577 LA ] Network Diagnostics #i5 Bl 45 i vk [ i .

SIS IS AT DURIT BT

Windows F /

1

a b~ ODN

(o2}
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Notice to users in Brazil

Este equipamento opera em carater secundario, isto e, nao tem direito a protecao contra interferencia prejudicial,
mesmo de estacoes do mesmo tipo, e nao pode causar interferencia a sistemas operando em carater primario.
(Res.ANATEL 282/2001).

Industry Canada (Canada)

This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference
that may cause undesired operation of the device.

This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly
prohibited per regulations of Industry Canada.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.

The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit
RF fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.

Industry Canada (Canada)

Cetappareil est conformealanormeRSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes:

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence recue, y compris celles
risquant d'altérer son fonctionnement.

Cet appareil a été congu pour fonctionner uniquement avec I'antenne fournie. L'utilisation de toute autre antenne
est strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement
interdite.

Pourempéchertouteinterférenceradioauservicefaisant!'objetd'une licence, cetappareil doit &tre utilisé al'intérieur
et loin des fenétres afin de garantir une protection optimale.



Si le matériel (ou son antenne d'émission) est installé a I'extérieur, il doit faire I'objet d'une licence.

L'installateur de cet équipement radio doit veiller a ce que I'antenne soitimplantée et dirigée de maniére a n'émettre
aucun champ HF dépassant les limites fixées pour I'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Taiwan NCC RF notice statement
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